Welcome to Vision!

Welcome to Vision 2024 pre-visualization software for entertainment design and production professionals. Vision allows you to
previz the conventional lights, moving lights, video, and other effects that make up a production, simulated in the context of the
event venue. Use Vision to program and cue your show, whether you are selling a concept to the client, testing lighting cues, or
conforming lighting systems for a new venue. You can previz without being at the venue or having a crew on standby. Experiment

with looks and cues, and review the options with clients and artists before the actual load-in.

For quick answers while using a feature in Vision, use Context-sensitive help.

New features

The following table contains a list of new and improved features for the initial release of the Vision 2024 software.

Feature Purpose Location
New Projector tool A new projector tool adds realistic projectors which can Adding projectors

throw light and cast shadows

Documentation Improvements

The following table lists major improvements to the documentation for the initial release of the Vision 2024 software.

Improvement Purpose Location




Improved online help system The online help system has a streamlined Table of Contents Online help system
performance and appearance and improved appearance. Use the mini Table of Contents
from the right panel to navigate through a topic's headings.
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Installing and launching Vision

The Vision installation program lists the installation system requirements, any known installation issues, and any information that
changed in the software after final online help was produced. To ensure a smooth installation, confirm that system requirements are

met and take note of any issues or incompatibilities prior to installing the software.

The installer includes an option to collect usage data for software improvement. You can select the type and amount of data

collected, and change this setting at any time from the Basic: Session tab or Advanced: Session tab in the Vision application.

If you plan to use a video capture source, it must be compatible with UVC (USB Video Class) and use a supported pixel format. For

more information, see Vision Capture Input Requirements.

The installer uses a serial number to determine whether the license is valid and to allow access to the correct number of universes.

Vision launches in demonstration mode when a valid license cannot be found. A sample file opens automatically, and a sample DMX
file is also loaded to the DMX recorder. Additional sample files are available in the Demo Documents folder within the Vision folder.
Only these files can be opened in demonstration mode, and they cannot be edited. The Vision watermark displays on the Scene
window viewports.

When Vision launches with a valid dongle or serial number, either open or create a scene file. If a file was sent from Vectorworks

using the Send to Vision command, Vision launches automatically and opens the file.

Launching in Safe Mode

If Vision quits unexpectedly, you will be prompted to relaunch the program in Safe Mode. This is only recommended if a custom
setting or inadequate hardware prevents you from opening Vision properly. In Safe Mode, all user settings are reset to factory
defaults, and any custom settings are lost. To prevent crashing, the scene is rendered at low quality; this mode is not suitable for
programming a show. "SAFE MODE" displays at the top left of the Scene window viewport when Safe Mode is active. To exit Safe
Mode, close and then relaunch Vision.

Using Vision with Vectorworks

The application window

Setting Vision preferences



https://forum.vectorworks.net/index.php?/articles.html/articles/tech-bulletins/vision-capture-input-requirements-r743/

Updating Vision

Updating the application

Command

Update Vision | Help

Between major releases, the Vision application is regularly updated by service packs. These are maintenance releases that
sometimes add new features and functionality, or provide smaller updates to address more urgent issues. For information about

Vision and service pack updates, see the Community Forums.

To update the Vision application:
1. Select the command.
If an update is available, the Vision Update Control Center opens to guide you through the process.
2. The Update Control Center may require an update. If so, click Update; it will update and launch.

3. The Update Control Center indicates in the text on the left whether an update is available, or your version of Vision is up

to date. If an update is available, click Update. If Vision is still open, you are prompted to close it.

During the update, the necessary files are automatically downloaded and installed. When complete, you can launch the

newly updated Vision.

Adding and changing serial numbers

Command

Vision Preferences Edit

During installation, you are prompted to enter the serial number provided with the Vision program (unless a dongle is in use). You
may need to change the serial number later to switch from an evaluation version to a full version, or to upgrade to a version with

more available universes.

To add or change a serial number:
1. Select the command.
The Vision Preferences dialog box opens.
2. Click Serial Numbers on the Session tab.

The Serial Number dialog box opens.


https://forum.vectorworks.net/index.php?/forum/58-vision/

3. Enter the serial number exactly as it appears on the label. The serial number is case sensitive. The letters O and | are not
used; enter the numbers 0 and 1 instead.

4. Click Save.
The Activation dialog box opens.
5. Click Activate to associate the serial number with the current workstation.

Alternatively, click Continue in Demo mode to use Vision in demonstration mode.

To view the license agreement, select Help > About, or click License Info on the Serial Number dialog box.

Updating the content library

Command

Update Library | ¢ Help (Windows)
e Vision (Mac)

The Vision content library can be updated from within Vision.

To check for and apply a library update:
Select the command.

If an update to the content library is available, it is automatically downloaded and applied.

Updating the dongle

Command

Update Dongle | ¢ Help (Windows)
e Vision (Mac)

In very limited cases, a dongle is used to activate the program. Prior to launching Vision, insert the dongle that came with your
software into an available USB port. At launch, Vision detects and verifies the dongle and provides access to the correct number of
universes. If using a dongle, it may need to be updated to run the latest version of Vision. You can check whether the dongle license

is up to date, and update the dongle expiration date based on your maintenance program.

To check on your maintenance program and update the dongle:
With the dongle inserted, select the command.
NOTE: Alternatively, run the VisionUpdater program from the Vision application folder.

The Vision Updater dialog box opens and indicates whether your dongle license is up to date. The number of available

universes and the dongle expiration date are displayed.
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Using Vision with Vectorworks

Vision software is designed to work with Vectorworks Spotlight software. For information on Vectorworks, visit vectorworks.net. For

information on using the Vectorworks program, refer to help.vectorworks.net.
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General modeling techniques

Vision relies on properly created models to optimize previz. Efficiently created files run faster and have better results.

When modeling, use the fewest number of polygons possible. A high-polygon item that only represents a small part of the scene
(such as a set piece) is an inefficient use of polygons. If an item represents only an inch or two of screen real estate, it is better to
create it as a low-polygon item.

Use textures to create a model that has a low polygon count but still looks great. Applying detailed textures to low-polygon objects

can give them a realistic appearance that rivals high-polygon scenes; see Object and fixture parameters. For more detailed

information on how to use textures, see the documentation for your modeling software.


http://www.vectorworks.net
http://help.vectorworks.net

Preventing instability

Command

Check VRAM Render

Occasional instability problems may occur during rendering, depending upon the capabilities of the computer in use. To avoid
crashing, ensure that the command is selected and displays with a check mark. Deselect the command for slightly faster rendering if

your system has not presented any issues.

The application window




Vision basics

The Vision application window contains the scene (displayed within the Scene window in either a single viewport or in four
viewports), the Scene Graph palette, the Properties palette, and the Tool bar, which contains the tool sets. Palettes and tool sets
may be opened, closed, and moved around as necessary. When the application closes, the latest workspace settings are restored for

the next session.
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The Scene Graph, Properties, and Software Console palettes can be opened from the Window menu. Click the Maximize button, or

double-click the palette title bar, to undock the palette.

Maximize
(Undock)

Scene Graph & X Close

Drag an undocked palette back into the Vision window to dock it as a tabbed palette. Drag the palette again, or double-click the

palette title bar, to return the palette to the original docked location.

Properties Scene Graph

Tabbed palettes



The Tool bar

Command Path Shortcut

Tools Window | e  Ctrl+Shift+T (Windows)
e Cmd+Shift+T (Mac)

The Tool bar consists of four tool sets containing commonly used tools; see Adjusting the view and Modifying scene objects and

fixtures.

To display the Tool bar, select the command.

Click at the top of a tool set to undock it, and drag it to the desired location.

Undock

Customizing the display

The tool set context menu provides options for customizing the user interface. Right-click on any tool set to open the context menu,
and select the desired options.

Menu command Description

Scene Graph Displays the Scene Graph palette
Properties Displays the Properties palette
Select Displays the Select tool set
Camera Displays the Camera tool set
Modify Scene Displays the Modify Scene tool set
Modify Object Displays the Modify Object tool set




Dark Theme Applies a dark color theme across the user interface. This is especially useful when Vision

is running in a dark environment.

Tool bar Controls the appearance of tool icons and text
Icons Only Displays only an icon for each tool
Text Beside Icons Displays a text label on the right side of each tool icon
Text Below Icons Displays a text label below each tool icon
Small/Medium/Large Icons Sets the size of tool icons
Grayscale Tools Displays the tool icons in grayscale. Deselect the option to display the tool icons in full
color.
Widgets Controls the display of editable fields in the Properties palette and in the Vision

Preferences and Document Preferences dialog boxes.

NOTE: The mouse wheel, arrow keys, and Page Up/Page Down keys can be used to
adjust the numerical parameter values controlled by text fields, sliders, and dials.

Text & Sliders Displays text fields and sliders

Dials & Text Displays dials and text fields.

NOTE: Dials are smaller than sliders; use dials to save screen space.

Text Only Displays text fields

Opening files
Merging files

Saving and exporting files

Exiting Vision

Common functions

The Scene window

Preferences

The application window

The Vision application window contains the scene (displayed within the Scene window in either a single viewport or in four
viewports), the Scene Graph palette, the Properties palette, and the Tool bar, which contains the tool sets. Palettes and tool sets
may be opened, closed, and moved around as necessary. When the application closes, the latest workspace settings are restored for
the next session.
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The Scene Graph, Properties, and Software Console palettes can be opened from the Window menu. Click the Maximize button, or
double-click the palette title bar, to undock the palette.
Maximize

(Undock)

Scene Graph F X Close

Drag an undocked palette back into the Vision window to dock it as a tabbed palette. Drag the palette again, or double-click the

palette title bar, to return the palette to the original docked location.

Properties Scene Graph

Tabbed palettes

The Tool bar

Command Path Shortcut

Tools Window | e  Ctrl+Shift+T (Windows)
e Cmd+Shift+T (Mac)




The Tool bar consists of four tool sets containing commonly used tools; see Adjusting the view and Modifying scene objects and

fixtures.

To display the Tool bar, select the command.

Click at the top of a tool set to undock it, and drag it to the desired location.

Undock
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Camera
tool set

Customizing the display

The tool set context menu provides options for customizing the user interface. Right-click on any tool set to open the context menu,
and select the desired options.

Menu command Description
Scene Graph Displays the Scene Graph palette
Properties Displays the Properties palette
Select Displays the Select tool set
Camera Displays the Camera tool set
Modify Scene Displays the Modify Scene tool set
Modify Object Displays the Modify Object tool set
Dark Theme Applies a dark color theme across the user interface. This is especially useful when Vision
is running in a dark environment.
Tool bar Controls the appearance of tool icons and text
Icons Only Displays only an icon for each tool
Text Beside Icons Displays a text label on the right side of each tool icon




Text Below Icons

Displays a text label below each tool icon

Small/Medium/Large Icons

Sets the size of tool icons

Grayscale Tools

Displays the tool icons in grayscale. Deselect the option to display the tool icons in full

color.

Widgets

Controls the display of editable fields in the Properties palette and in the Vision

Preferences and Document Preferences dialog boxes.

NOTE: The mouse wheel, arrow keys, and Page Up/Page Down keys can be used to

adjust the numerical parameter values controlled by text fields, sliders, and dials.

Text & Sliders

Displays text fields and sliders

Dials & Text Displays dials and text fields.
NOTE: Dials are smaller than sliders; use dials to save screen space.
Text Only Displays text fields
Opening files
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The Scene window
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Data exchange for previsualization

GDTF and .mvr files enable a seamless exchange of data between modeling programs, lighting consoles, and visualizers such as

Vision. GDTF (General Device Type Format) is used to save and transfer custom fixture data.

NOTE: You can download .gdtf files from the GDTF Share ( gdtf-share.com ) or create your own in the online Fixture Builder
( fixturebuilder.gdtf-share.com ). See the GDTF help ( gdtf-share.com/help/en/help/gdtf builder/index.html ) for more

information about these platforms.

GDTF files cannot be imported directly in Vision, but only as part of an MVR (My Virtual Rig) import. MVR files enable the transfer of

all scene objects and parameter data. See Merging files for more information about MVR.



https://gdtf-share.com/
https://fixturebuilder.gdtf-share.com
https://gdtf-share.com/help/en/help/gdtf_builder/index.html

Setting the fixture type for MVR import

When importing a .mvr file from Vectorworks, you have the option to use GDTF fixtures or Vision fixtures, but it is also possible to
use both in one scene. In Vision, this option is set by the Use Fixture Types from parameter in the Import options dialog box.

However, the fixture import also depends on the fixture mode(s) specified in Vectorworks.

NOTE: For more information on fixture modes in Vectorworks, navigate to help.vectorworks.net and refer to the section on

“Lighting device properties.”
Set the parameters in Vectorworks and Vision for the desired fixture import:
e To use only GDTF fixtures:
¢ In Vectorworks, there is no need to specify a fixture mode.

¢ In Vision, select GDTF as the fixture type. GDTF files are created for all fixtures in the scene, even if no GDTF Fixture

Mode is specified in Vectorworks.
e To use only Vision fixtures:
¢ In Vectorworks, specify the Fixture Mode. You can also specify the GDTF Fixture Mode or set it to None.
e In Vision, select Vision as the fixture type.
e To use a mix of GDTF and Vision fixtures:

e  For fixtures that should use GDTF data: In Vectorworks, specify only the GDTF Fixture Mode and set the Fixture
Mode to None.

e For fixtures that should use Vision data: In Vectorworks, specify the Fixture Mode. You can also specify the GDTF

Fixture Mode or set it to None.

¢ When importing the mixed file in Vision, select Vision as the fixture type.

Opening files
Merging files

Import options
Updating GDTF fixtures

Opening files

Vision opens .mvr, .gITF/glb, .vsn, .v3s, .3ds, .0bj, and .esc files that were created or saved in Vision, or exported from another

program such as Vectorworks. Consider the advantages of Merging files instead.

NOTE: When .mvr, .3ds, and .obj files are opened, the Use Normals setting on the Advanced: Rendering tab is enabled by

default, even if it was previously deselected. If the normals are incorrect, they can be fixed when setting the Import options or

by Adjusting the normals.



http://help.vectorworks.net

The three most recently opened files are listed in the File menu. Select a file to open it.

NOTE: If a file was sent from the Vectorworks program using the Send to Vision command, Vision launches automatically and
opens the file.

To open an existing file:

1. Select File > Open.

2. Select the file to open, and click Open.

NOTE: If the file was created with an earlier version of Vision (prior to Vision 2022), the File Migrator dialog box
opens. Click OK to convert the file to .vsn and open it in Vision. By default, the program renames the converted file
and keeps the original file intact.

Depending on the selected file format, the Import options dialog box opens.

3. Specify the import options.

To create a new file:

Select File > New.

A new, blank file opens.

Merging files

Saving and exporting files

Preferences

Merging files

Command Path

Merge File

Vision can merge .mvr, .gITF/glb, .vsn, .v3s, .3ds, .obj, and .esc files. Merging .muvr files is recommended for updating the Vision
model with changes exported from Vectorworks. MVR (My Virtual Rig) uses unique IDs (UUIDs) to track the scene contents. This
allows Vision to apply edits from a merged .mvr file without duplicating the original scene geometry. Applicable edits include new
content and any changes to the position, rotation, and patching of existing items. The scene contents are imported as separate

items, which can be selected and edited individually in Vision.

NOTE: If Update existing MVR objects is deselected in the Import options dialog box, all geometry in the merged .mvr file will
be imported without unique IDs. This means that any pre-existing geometry in the open scene file will be duplicated, not

updated.

Like MVR, .esc files can be used to import controllable lighting devices and their focus points. A unique benefit of .esc files is the
ability to transfer customized lighting device data such as gobo wheels, lamp rotations, and shutter cuts. However, for organizational

purposes, merging by ESC requires that you group the scene contents into separate files when exporting from another program. For



example, to organize by truss, merge a separate exported file for each truss and its attached lights. To organize by PSN or DMX
transform, merge a separate exported file for objects and lighting devices that should transform together.

To merge a file:

1. Select the command.

2. Select the file to merge, and click Open.

Depending on the selected file format, the Import options dialog box opens.

3. Specify the import options.

When a file is merged in Vision, it displays as a heading, or “layer,” in the Scene Graph palette. Drag and drop the layer to the desired
location (see Organizing the scene contents). When a layer is selected, all items contained in that layer can be moved and

transformed as a group.

The Scene Graph palette

Data exchange for previsualization

Import options

Opening files
Saving and exporting files

Import options

When certain file formats are opened or merged in Vision, the Import Options dialog box opens. The available options depend on

the file format.

¥ Click to show/hide the parameters.

Parameter Description

Mesh Smoothing Select how mesh smoothing is applied to imported objects.

¢ Imported: Determines whether objects appear faceted or smooth based on the normals in
the imported file (the normals are not recalculated).

e Custom Crease Angle: Determines whether objects appear faceted or smooth based on
the specified Crease Angle (the normals are recalculated).

* None: Forces all objects to appear flat or faceted (the normals are recalculated).

Crease Angle When Custom Crease Angle is selected, enter the desired angle to smooth all mesh objects
rendered with OpenGL; enter a higher value for smoother surfaces (range: 0-180)

Units in File Select the units for the imported file; this affects the size of the imported objects




Use Fixture Types from

(MVR only)

Select the type of fixture to use: GDTF or Vision. It is also possible to use both types in a scene.

The fixture import depends on the Use Fixture Types from setting, as well as the fixture mode
settings made in Vectorworks. See Setting the fixture type for MVR import.

NOTE: When GDTF fixtures are imported, some of their parameters are disabled on the
Properties palette, and all GDTF fixtures are disabled in the Patch dialog box.

Truss Texture

(MVR only)

Select the truss texture, or select Imported to apply truss textures from the imported file

Coordinate System

Select the coordinate system for the imported file:

e Vectorworks (right-handed, Z-up, Y-forward)
e Vision (left-handed, Y-up, Z-forward)

NOTE: Select Vectorworks if the file was exported from the Vectorworks program.

Flip moving lights

Rotates all moving lighting devices by 180° on the X axis, so Vectorworks content can be

oriented correctly in Vision

Update existing MVR objects

(MVR only)

Updates the open scene file without duplicating the existing geometry

Setting document preferences

Data exchange for previsualization

Opening files




Merging files

Saving and exporting files

Saving and exporting files

Vision's default file format is .vsn. If the Vision file contains video, the video files are saved in a separate textures folder in the same
location as the .vsn file.

Vision's legacy file format is .v3s. The image and video files associated with the Vision file are saved in a separate textures folder in
the same location as the .v3s file.

Whether you are saving a .vsn file or exporting a .v3s file, do the following to ensure that textures are properly saved:

e Save each Vision file in a unique folder. If you save two Vision files in the same folder, this will cause them to share a
textures folder, with unpredictable results.

e Provide unique names for the textures associated with the Vision file (the textures are named according to the containing
folder).

Saving files

Command Path Shortcut
e Save File e  Ctrl+S (Windows)
e SaveAs e Cmd+S (Mac)

To save a file:

e To save the current file, select Save.

e To save the file with a different name or to a different location, select Save As.

The title bar indicates whether the save was successful.

NOTE: If you sent a file from Vectorworks using the Send to Vision command, immediately save the file in Vision. The file will be

lost if you close Vision without saving it.

Exporting to legacy format

Command

Export as Vision Legacy File Export

If you need to open the scene file in an earlier version of Vision (prior to Vision 2022), export the scene as a .v3s file.

NOTE: Lasers are not supported in .v3s files.

To export a file to .v3s format:



1. Select the command.

2. Specify the file name and location, and click Save.

The title bar indicates whether the export was successful.

Exiting Vision

Common functions

Purging items from a file

Command Path

Purge Edit

The Purge command removes specified items from the scene and reduces the size of the .vsn file.

To purge unused items from a .vsn file:
1. Select the command.
The Purge dialog box opens.

¥ Click to show/hide the parameters.

Parameter Description
Select All Selects all items in the list
Deselect All Deselects all items in the list

Show preview | Displays a thumbnail graphic of each resource in the file

Item list Lists each item in the file. Click in the Name column to select each item to purge.
e To sort the list by Name or Size (in kilobytes), click the appropriate column header.

e To resize the thumbnail graphics, click-and-drag the Preview header.

2. Select the items to remove.
3. Click OK to complete the purge.

If needed, select the Undo command to undo the purge.

Saving and exporting files

Common functions




Common functions

The Vision program’s Edit menu commands perform operations common to most software programs.

¢ Undo/Redo: Undoes or redoes the last performed action.

e Cut/Copy/Paste: Cuts or copies an item to the clipboard; pastes the item from the clipboard.

Opening files
Merging files
Saving and exporting files

Using saved sets

You can save the specified settings for reuse, and edit or delete saved sets.

» Click to show/hide the parameters.

Parameter

Description

Settings

Displays the name of the current saved set; to use a different saved set, select it

from the list of saved sets.

NOTE: Any set in the list with angle brackets indicates either a Vision default
or a variable set, not a saved set. For example, <Active Settings> refers to

the dialog box’s current parameters, which are not saved as a set.

Save

Opens the Save Settings dialog box to name and save the current parameter

settings; the saved set is added to the Settings list

Manage

Opens the Manage Saved Sets dialog box, to rename or delete saved sets. Select

a name from the list, and then click the appropriate button.

NOTE: When renaming a set, if the entered name is already assigned to
another set, you are prompted to confirm that you want to replace the

existing set.

Setting Vision preferences

Setting document preferences

Saving the scene as an image

Saving the scene as a movie




Exiting Vision
To close the Vision program along with the open file:

Select File > Exit (Windows) or Vision > Quit Vision (Mac).

Opening files
Merging files
Saving and exporting files

The Scene window

Command Shortcut

Toggle Number of Viewports | Window | M

The scene file contains the geometry that represents fixtures, trusses, pipes, set pieces, venue walls, and so on. The Scene window

displays the scene file, and it is where visualization occurs.

Drag the divider along the edge of the Scene window to adjust the amount of space taken up by the Scene window and any open

palettes.

Drag the
divider to
adust the size
aof the palettes
and the Sceng
window

The Scene window can be viewed as a single viewport or as four viewports, each with a different view.
NOTE: Four viewports are helpful when setting up a complex focus with many fixtures at odd angles.

To toggle the number of viewports in the Scene window, select the command.



Full screen view

Command Shortcut

Toggle Fullscreen | Window | e  Ctrl+Shift+F (Windows)
e Cmd+Shift+F (Mac)

The Toggle Fullscreen command toggles between a maximized full screen of the bottom right viewport and the normal, resizable

display of the Vision program.

To switch to full screen view:
1. Select the command.
The bottom right viewport expands, filling the entire screen.

2. To exit full screen view, press the Esc key, or press the keyboard shortcut again.

Ambient light in the Scene window

In Vision, ambient lighting simulates the house lights in an indoor scene or the natural lighting in an outdoor scene. To set the

azimuth or elevation of ambient light, see the Advanced: Environment tab.

Ambient Intensity controls the brightness of ambient light throughout the scene, and Exposure controls the perceived brightness—
mimicking the camera’s or the eye’s adaptation to changing light levels. These settings can be adjusted from the Basic document

preferences and the Advanced: General tab, or from the Properties palette.

The Ambient Intensity can also be adjusted manually using keyboard shortcuts.

¢ Toincrease the setting by 1, press Ctrl+Shift+L (Windows) or Cmd+Shift+L (Mac); to decrease the setting by 1, press
Ctrl+Shift+K (Windows) or Cmd+Shift+K (Mac).

¢ Totoggle the setting by 50, press Ctrl+Shift+) (Windows) or Cmd+Shift+) (Mac). If the Ambient Intensity is less than 50,
the toggle increases the setting by 50. If the Ambient Intensity is 50 or more, the toggle decreases the setting by 50.

Looked At point

Command Shortcut

Toggle Looked At Point | Window | e  Ctrl+Shift+O (Windows)
e Cmd+Shift+0 (Mac)

Each viewport in the Scene window includes a Looked At point to indicate where the camera is looking. All zooming and rotation
operations are based on the Looked At point; it is the center of rotation for the Flyover tool. Use the tools in the Camera tool set to

move the Looked At point. The Push Looked At Distance parameter on the Basic: Interactive tab or Advanced: Interactive tab sets

the minimum distance from the camera to the Looked At point. This distance can be adjusted to optimize close-ups or distant views.



To toggle the Looked At point on and off, select the command.

Grid view

Command Path Shortcut

Toggle Grid | Window | e  Ctrl+Shift+G (Windows)
e Cmd+Shift+G (Mac)

The Toggle Grid command toggles the display of a grid in the Scene window. The grid center is the document origin, and each
square of the grid measures 5 feet by 5 feet. When viewing the Scene window as four viewports, the command applies to all

viewports.

To display the grid, select the command.

Scene window rendering

Command

e  Wireframe Context menu

e Solid

Each viewport can display as a solid or wireframe rendering.

To set the rendering of a viewport:

Right-click on the viewport and select the desired command.

Scene window standard views

Each viewport in the Scene window can display in one of nine preset views, or in a custom view that can be saved (see Saving
views). The label in the top left corner of the viewport indicates the current view; “User” designates either a custom view or one of
the isometric preset views.

The six standard preset views can be accessed from the viewport context menu; right-click on the viewport and select one of the
views. Alternatively, use the shortcut keys on the numeric keypad to access the standard and isometric views. Isometric views are

labeled as User views.

» Click to show/hide the parameters.

View Numeric keypad shortcut Available in context
menu




Front Left Isometric 1 No
Front 2 Yes
Front Right Isometric 3 No
Left 4 Yes
Top 5 Yes
Right 6 Yes
Rear Left Isometric 7 No
Back 8 Yes
Rear Right Isometric 9 No

Saving views

A custom view can be saved and restored later. Up to nine Scene window views can be saved with the file. Use the keyboard

numbers for these operations; do not use the numeric keypad, which controls the standard views (see Scene window standard

views).

To save a view:

1. Click the viewport with the view to save.

2. Press the Ctrl key (Windows) or Cmd key (Mac), and any number key (1-9) on the keyboard.

The current viewport view settings are saved to the keyboard shortcut.

To restore a view:

Press the designated number key (1-9) to restore the saved view.

If the saved views do not display as expected, they can be reset. To reset all views:

Right-click on the viewport and select Set Default Views from the context menu. The saved views are replaced with the

standard preset views.

Adjusting the view

Setting the DMX provider




Adjusting the view

Use the Camera tools to adjust the view.

Flying over

Tool set Shortcut

Flyover | Camera [ Shift+C

The Flyover tool simulates movement over and around a real-world scene. The center of rotation is the Looked At point.
To fly over a scene:

1. Click the tool.

2. Within the viewport, click and drag in the direction of movement while holding down the mouse button.

The viewport label displays “User,” since the view is a custom view and not one of the preset views.

The Flyover tool can be used in boomerang mode if you have a center mouse button. Hold down Ctrl+center mouse button
(Windows) or Cmd+center mouse button (Mac) to temporarily pause the current tool and switch to the Flyover tool. Release the
buttons to return to the previous tool.

Zooming

Tool set Shortcut

The Zoom tool controls how close or far away objects appear in the viewport. Zoom in to get a close-up view of a detail, and zoom

out to get a broader view of the scene.

Zooming is based on the Looked At point, not the mouse location. The speed of zooming depends on the Push Looked At
Distance specified on the Basic: Interactive tab or Advanced: Interactive tab.

To zoom in or out of a viewport:

1. Click the tool.

2. Within the viewport, click and drag while holding down the mouse button. Move the cursor up to zoom in on the

viewport, or move the cursor down to zoom out of the viewport.



On a wheel-mouse, roll the mouse wheel forward to zoom in on the viewport (the Zoom tool does not need to be selected). Roll the
mouse wheel backward to zoom out of the viewport.

This feature will not work properly if standard scrolling is disabled in the mouse setup. For example, if the mouse’s scrolling size is
set to “none,” mouse zooming in Vision is disabled. (The specific settings required for this feature depend on the type of mouse.)

Panning

Tool Tool set Shortcut

Pan Camera H

The Pan tool moves the scene around in the viewport, changing the area of display.

To pan within the viewport:
1. Click the tool.
NOTE: Alternatively, depending on the type of mouse being used, press and hold the center mouse button to pan.

2. Within the viewport, click and hold the mouse button, and drag to move the scene.

The Pan tool can be used in boomerang mode. Hold down the Space bar or the center mouse button to temporarily pause the

current tool and switch to the Pan tool. Release the Space bar or the mouse button to return to the previous tool.

Fitting the view to objects

Tool set

Fit To Objects | Camera

The Fit To Objects tool changes the view to zoom to the selected objects. When the Scene window displays four viewports, this tool
applies only to the bottom right viewport.

To fit the view to objects:

1. Select one or more objects.

NOTE: To fit the zoom level to all objects in the Scene window, select ROOT from the Scene Graph palette.

2. Click the tool.

The zoom level adjusts to the selected objects.



The Scene Graph palette

The Properties palette

Setting the DMX provider

Setting the DMX provider

Command

Select DMX Provider DMX

To properly communicate with a connected console, specify the DMX protocol. See the Community Forums for specific information

about DMX connectivity. Some DMX providers limit the number of universes.

NOTE: A Vision dongle is required to use MA-Net2.

To set the DMX provider:

1. Use an Ethernet cable to connect the console to the Vision computer. Configure the computer’s IP address and Sub-net
Mask according to your lighting controller’s specifications. Some consoles provide utilities for this configuration; check
the console documentation. Make sure your firewall is off temporarily while selecting the provider, and then re-enable it.

2. Launch Vision.
3. Select the command.
The Select DMX Provider dialog box opens.

4. The currently selected protocol displays with an asterisk. Select a different protocol from the list if needed. The

availability of protocols in the list depends on the platform.

5. If you selected MA-Net3, the Select MA3 Software Version dialog box opens. Follow the steps in Connecting to MA-Net3.

NOTE: The DMX Viewer does not work with MA-Net3.

Connecting to MA-Net3

Using the MA viz-key, Vision can connect to a grandMA3 console or onPC computer and join an MA-Net3 session. First, install the
viz-key driver and update Vision to communicate with the specific version of grandMA3 software that you will use for visualization.

Once the update is complete, you can select the desired grandMA3 software version in Vision and connect to the MA-Net3 network.

NOTE: Vision and the grandMA3 must use the same grandMA3 software version to visualize a show.

Configuring the viz-key connection

To install the viz-key driver and update Vision to communicate with your grandMA3 software:


https://forum.vectorworks.net/index.php?/topic/45676-dmx-connectivity-articles/

1. Follow the steps in Setting the DMX provider; select MA-Net3 in the Select DMX Provider dialog box.

2. The Select MA3 Software Version dialog box opens. Select Updater from the list.

3. The Select MA-Net3 Interface dialog box opens. Select the network interface.

NOTE: Only <Auto Interface> is available when connecting to a grandMA3 software version prior to 1.4.

4. Follow the instructions for installing and updating the viz-key driver in the following article: forum.vectorworks.net/

index.php?/articles.html/articles/connect-grandma-to-vision-2021-r837/.

Once you have run the updater for a specific version of the grandMA3 software, that version becomes an option in the
Select MA3 Software Version dialog box, as described in the following section.

Joining an MA-Net3 session

Once you have completed the steps in the previous section, Vision can join an MA-Net3 session.

To join an MA-Net3 session:

1. Follow the steps in Setting the DMX provider; select MA-Net3 in the Select DMX Provider dialog box.

2. The Select MA3 Software Version dialog box opens. Select the desired version of grandMA3 software from the list.

3. The Select MA-Net3 Interface dialog box opens. Select the network interface.

4. Follow the instructions for connecting to specific versions of the grandMA3 software in the following

article: forum.vectorworks.net/index.php?/topic/45676-dmx-connectivity-articles/

Configuring multiple input devices

Command

Select DMX Provider DMX

Vision allows multiple DMX input devices to be configured and used at the same time, so you can visualize several different types of

DMX input simultaneously.

NOTE: Multi-Input is limited to 64 universes.

To configure multiple input devices:

1. Select the command.

The Select DMX Provider dialog box opens.

2. Select Multi-Input as the DMX protocol.

The DMX Source Selection dialog box opens.


https://forum.vectorworks.net/index.php?/articles.html/articles/connect-grandma-to-vision-2021-r837/
https://forum.vectorworks.net/index.php?/topic/45676-dmx-connectivity-articles/

3.

Connect any of the DMX universes within Vision by selecting the universe, and then selecting the DMX protocol from the
list.



Preferences

All settings with a major impact on the application graphics and performance are controlled by the Vision preferences. These

settings affect every file opened in Vision. See Setting Vision preferences.

All settings that determine the look of the scene are controlled by the document preferences. These settings affect the current file

only. See Setting document preferences.

There are Basic and Advanced modes for both sets of preferences. Basic mode includes the frequently used settings, while
Advanced mode includes all the settings available for configuration. Click the Basic or Advanced button at the bottom of the
preferences dialog box to switch between the modes. The title of the dialog box indicates which mode is active. Basic mode is active
by default.

Modifying scene objects and fixtures

PSN transforms
DMX transforms

Assigning textures

Saving the scene as an image

Saving the scene as a movie

Using DMX controls
The DMX recorder

Setting Vision preferences

Command

Vision Preferences Edit

Vision preferences control graphics quality and performance. The settings apply to every file you open, every time you run the

program. Save and manage the settings from any tab in the Vision Preferences dialog box; see Using saved sets.

The dialog box has Basic and Advanced modes. Basic mode includes the frequently used settings. Advanced mode provides more

settings for finer control.

In both modes, the Performance-Quality slider can be used to globally edit the settings for better application performance or

graphics quality. As you drag the slider, the settings in the dialog box automatically update.

To change the Vision preference settings:

1. Select the command.

The Vision Preferences dialog box opens in Basic or Advanced mode, indicated by the title.

2. The Basic Vision preferences open by default. Click the Advanced button to open the Advanced Vision preferences.




3. Click each tab to set the preferences, or use the Performance-Quality slider to make global changes.
4. Click Apply to apply the settings while the Vision Preferences dialog box stays open.

5. Click OK to apply the current settings and close the dialog box. Cancel closes the dialog box without applying the current
settings, but it does not undo any previously applied settings.

Basic Vision preferences

Basic: Graphics tab

Click the Graphics tab to set preferences that control graphics and display.

¥ Click to show/hide the parameters.

Parameter Description
Resolution Sets the maximum screen resolution for the Scene window.
Quality

NOTE: If the Scene window resolution is smaller than the specified value, Vision uses the Scene window
resolution when rendering.

Render Renders shadows; deselect this option for better performance

shadows

Basic: Interactive tab

Click the Interactive tab to set preferences for interactive drawing features, such as the grid, selection boxes, and the Looked At
point (see Looked At point).

¥ Click to show/hide the parameters.

Parameter Description

Display grid Displays the grid in all viewports

Display Looked At Displays the Looked At point in all viewports

point

Display selection Displays the bounding box of the selected object(s)

Push Looked At Sets the minimum distance from the camera to the Looked At point. Larger values optimize distant

Distance views and enable faster navigation through the scene. Smaller values optimize close-up views and small
camera movements.
Vision moves the Looked At point to maintain the specified distance when zooming (see Zooming).




Basic: Session tab

Click the Session tab to toggle the tooltips on and off, set error reporting preferences, view license information, and change serial

numbers.

» Click to show/hide the parameters.

Parameter

Description

Enable
PSN

Globally enables or disables PosiStageNet (PSN) object location data. When disabled, the PSN server cannot identify

Tracker ID data over the network.

Enable
tooltips

Displays tooltips when the cursor hovers over tools, preferences, and properties in the application

Error

Reporting

Sends anonymous information about application crashes and other basic usage statistics to Vectorworks to help

improve the software. Four levels of information can be selected.

Send nothing: When you activate Vision software, we always collect general data about the operating system,

graphics card, monitor resolution, and Vision version.

Send crash details: In addition to the general information that is always collected, this allows us to receive
additional information in the event of a crash, including idle time, alerts received, and graphics card operations
prior to the crash.

Send crash details and light usage patterns: Selecting this option invaluably assists us with product
development while maintaining user privacy. In addition to the previously listed information, we are able to
duplicate actions taken before a software crash, review undo actions, determine which objects may have been
selected, and view Vision-related file paths. We cannot see the data in your scenes, and the reporting has no
impact on your software operations. Reporting happens in the background as you work and should not affect
your workflow.

Send crash details and verbose usage patterns: Selecting this option invaluably assists us with product
development while maintaining user privacy. In addition to the information gathered through the light usage
pattern option, we are able to upload additional information such as tool and command selection. We cannot
see the data in your scenes, and the reporting has no impact on your software operations. Reporting happens
in the background as you work and should not affect your workflow.

Serial

Numbers

Opens the Serial Number dialog box to add or change a serial number for the Vision product; see .

Click License Info to view the license agreement.

Advanced Vision preferences

Advanced: Graphics tab

Click the Graphics tab to set preferences that control graphics and display.

NOTE: "Fixtures" include lighting devices and lasers.




¥ Click to show/hide the parameters.

Parameter

Description

Resolution Quality

Sets the maximum screen resolution for the Scene window.

NOTE: If the Scene window resolution is smaller than the specified value, Vision uses the Scene
window resolution when rendering.

Texture Quality

Sets the quality level for textures and controls their resolution. Higher quality results in more detail but

slower rendering.

Surface Light
Quality

Sets the quality level for light emitted from a fixture. Higher quality results in more accurate beams and

surface lighting, but slower rendering.

Render Fixtures

Specifies whether or not fixtures are rendered, or rendered in black

Render shadows

Displays shadows; deselect this option for better performance

Shadow Sets the quality level for shadows. Higher quality results in more realistic shadows but slower rendering.
Quality

Dynamic Specifies which items cast shadows in the scene.

Shadows

e Objects & Fixtures: All objects and fixtures cast shadows.
e Objects: All objects cast shadows, but fixtures do not.

e None: All static objects cast shadows, but dynamic fixtures and objects do not.

NOTE: If the Texture Quality is Medium, High, or Very High, all objects become dynamic, and shadows

display only if Objects & Fixtures or Objects is selected.

Render haze

Displays haze; deslect this option for better performance

Haze Sets the rendering style used for haze
Rendering
Style
Haze Specifies the rendering quality of haze, but does not control the haze density or amount. Higher quality
Rendering results in more realistic light beams for any Haze Rendering Style, but it may slow the rendering.
Quality
Use haze Displays the Haze Texture Style selected in the document preferences; see Advanced: Haze tab
texture
Gamma Adjusts the contrast and brightness of midtone colors without changing black or white
Enable VSync It is recommended that you enable VSync to prevent “tearing” and other graphical inconsistencies, and to

save battery life.




Disabling VSync may improve performance, but it should only be done for testing purposes.

Advanced: Interactive tab

Click the Interactive tab to set preferences for interactive drawing features, such as the grid, selection boxes, and Looked At point
(see Looked At point).

¥ Click to show/hide the parameters.

Parameter Description

Display grid Displays the grid in all viewports

Display Looked At Displays the Looked At point in all viewports

point

Display selection Displays the bounding box of the selected object(s)

Push Looked At Sets the minimum distance from the camera to the Looked At point. Larger values optimize distant

Distance views and enable faster navigation through the scene. Smaller values optimize close-up views and small
camera movements.
Vision moves the Looked At point to maintain the specified distance when zooming (see Zooming).

Advanced: Session tab

Click the Session tab to toggle the tooltips on and off, set error reporting preferences, view license information, and change serial
numbers.

¥ Click to show/hide the parameters.

Parameter Description

Enable Displays tooltips when the cursor hovers over tools and parameters in the application

tooltips

Error Sends anonymous information about application crashes and other basic usage statistics to Vectorworks to help
Reporting improve the software. Four levels of information can be selected.

¢ Send nothing: When you activate Vision software, we always collect general data about the operating system,
graphics card, monitor resolution, and Vision version.

¢ Send crash details: In addition to the general information that is always collected, this allows us to receive
additional information in the event of a crash, including idle time, alerts received, and graphics card operations
prior to the crash.

¢ Send crash details and light usage patterns: Selecting this option invaluably assists us with product
development while maintaining user privacy. In addition to the previously listed information, we are able to

duplicate actions taken before a software crash, review undo actions, determine which objects may have been




selected, and view Vision-related file paths. We cannot see the data in your scenes, and the reporting has no
impact on your software operations. Reporting happens in the background as you work and should not affect

your workflow.

¢ Send crash details and verbose usage patterns: Selecting this option invaluably assists us with product
development while maintaining user privacy. In addition to the information gathered through the light usage
pattern option, we are able to upload additional information such as tool and command selection. We cannot
see the data in your scenes, and the reporting has no impact on your software operations. Reporting happens
in the background as you work and should not affect your workflow.

Serial Opens the Serial Number dialog box to add or change a serial number for the Vision product; see .

Numbers N . .
Click License Info to view the license agreement.

Preferences

Setting document preferences

The Scene Graph palette

Modifying scene objects and fixtures

PSN transforms
DMX transforms

Assigning textures

Saving the scene as an image

Saving the scene as a movie

Using DMX controls
The DMX recorder

Setting document preferences

Command

Document Preferences File

Document preferences control the look of the scene. The settings only apply to the current file, and they remain in effect until they

are changed.

The Document Preferences dialog box has Basic and Advanced modes. Basic mode includes the frequently used settings. For finer
control, Advanced mode provides more settings organized by tabs. The settings can be saved and managed from any tab in

the dialog box; see Using saved sets. When a .esc or .mvr file is opened in Vision, the most recent settings are applied.

NOTE: Document preferences can also be set from The Properties palette.

To change the preference settings in the file:

1. Select the command.

The Document Preferences dialog box opens in Basic or Advanced mode, indicated by the title.




2. The Basic document preferences open by default. Click the Advanced button to open the Advanced document
preferences.

3. Set the preferences. Click Apply to apply the settings while the Document Preferences dialog box stays open.

4. Click OK to apply the current settings and close the dialog box. Cancel closes the dialog box without applying the current
settings, but it does not undo the previously applied settings.

Basic document preferences

Set the general display and haze preferences.

NOTE: "Fixtures" include lighting devices and lasers.

» Click to show/hide the parameters.

Parameter Description
Ambient Sets the amount of light in the entire scene when fixtures are off. No shadows are created by ambient lighting. To
Intensity adjust the ambient light level using keyboard shortcuts, see Ambient light in the Scene window.

To modify the color and brightness of ambient light, set the Ambient Color from the Advanced: Environment tab.

Haze Amount Controls the amount of haze.

NOTE: For faster rendering, disable light beams by setting the Haze Amount to 0%.

Haze Density Controls the density of haze for all Haze Rendering Style options

Cast shadows | Controls the display of shadows for all objects and layers. To decrease rendering time for large files or DMX
transforms, deselect this option.

NOTE: You can override the Render shadows preference for specific items in the scene; set the Cast
shadows option on The Properties palette to toggle shadows on or off for selected objects and layers.

Advanced document preferences

Advanced: General tab

Click the General tab to set various display preferences.

NOTE: "Fixtures" include lighting devices and lasers.

» Click to show/hide the parameters.

Parameter Description




Ambient Intensity

Sets the amount of light in the entire scene when fixtures are off. No shadows are
created by ambient lighting. To adjust the ambient light level using keyboard
shortcuts, see Ambient light in the Scene window.

To modify the color and brightness of ambient light, set the Ambient Color from
the Advanced: Environment tab.

Exposure

Controls how much light enters the virtual camera lens. Values above 1.00 increase
the exposure and values below 1.00 decrease it.

NOTE: The default setting of 1.00 is best for most scenes, but you may want to
adjust for final rendering. Check the target lux values on the Advanced: Heat
Map tab, then modify the exposure as needed.

Haze Amount

Controls the amount of haze.

NOTE: For faster rendering, disable light beams by setting the Haze Amount
to 0%.

Contrast

Controls the difference between light and dark areas in the scene. Increasing this
value makes the difference more intense, while decreasing it can add a washed-out
effect.

Brightness

Controls brightness in the scene by adjusting the comparative luminance of each

pixel.

NOTE: The default setting of 0 (zero) is best for most scenes. To modify the
overall scene lighting, first adjust the Ambient Intensity, then the Exposure,

and finally the Contrast or Brightness if needed.

Camera FOV

Sets the horizontal field of view in the scene. Increase the value to widen the field

of view, and decrease the value to narrow it.

Advanced: Rendering tab

Click the Rendering tab to set the rendering preferences.

} Click to show/hide the parameters.

Parameter

Description

Use normals

Enables advanced lighting when valid normals are present. Normals indicate which
direction the scene geometry is facing, to troubleshoot rendering issues. Select

Render Normals to view the normals in the drawing.

NOTE: When .3ds and .obj files are opened, this option is enabled by default.




Use face culling

For better performance, renders only the camera-facing geometry.

NOTE: If geometry displays incorrectly, try Adjusting the winding order.

Diffuse Strength

Multiplies the intensity of diffuse lighting, which has the same brightness no matter
the camera view.

NOTE: Use this setting primarily for testing. To adjust the amount of diffuse
lighting, modify the Ambient Intensity or Exposure instead.

Specular Strength

Makes objects appear shinier by brightening their highlights.

NOTE: Use this setting primarily for testing. To increase or decrease the

amount of specular highlighting, adjust the Exposure instead.

Bump Strength

Multiplies the intensity of the bump effect for all textures.

NOTE: To finely adjust the bump strength, modify the grayscale shades in the

bump texture image.

Render normals

Shows the normals of the scene geometry by rendering them as RGB colors. The

colors adjust to the camera view.

e Red indicates left-facing normals.
e Green indicates top-facing normals.

e  Blue indicates front-facing normals.

NOTE: If an object is reflecting light incorrectly, its normals might be inverted;

try Adjusting the normals.

Render specular

Uses color coding to indicate the specular reflectivity of objects (metallic objects

should use the metal’s color).
e White indicates high reflectivity.
e Black indicates no reflectivity.

e  Gray indicates low reflectivity. An overall gray or muted appearance is expected

if the Texture Quality is low or if a reflective texture image is not applied.
e Color indicates metal reflectivity.
NOTE: Select the check box to test the specular lighting. For example, test

whether a highly reflective texture is applied correctly when the Texture
Quality is high.




Cast shadows

Controls the display of shadows for all objects and layers. To decrease rendering
time for large files or DMX transforms, deselect this option.

NOTE: You can override the Render shadows preference for specific items in
the scene; set the Cast shadows option on The Properties palette to toggle

shadows on or off for selected objects and layers.

Send NDI stream

Outputs a live NDI stream of Vision.

NOTE: Select this option to send an NDI stream of Vision to Disguise EVO, a

media server, a video-sharing platform, and so on.

Render Video

Controls how video screens are rendered.
e On: Enables video playback.

e Screen Test Image: Displays the screen images that were specified in
Vectorworks when the .mvr file was exported. If no images were specified, the

screens appear gray.

e Render Video with Disguise: Blacks out the video screens, so Disguise can

render video.

e  Off: Blacks out the video screens.

NOTE: The options Render Video with Disguise and Off perform the same

function; select either option to stop rendering video screens in Vision.

Far Clip Plane Distance

Sets the distance (in inches) to the far clip plane, which is the boundary of the
visible scene. All items within the Far Clip Plane Distance are visible, while items
beyond this distance are “clipped” out of view. Lower distance values can improve

shadow quality, so extremely high values are not recommended.

To set the optimal distance for your scene, zoom out to the furthest extent
required for previz. Decrease the Far Clip Plane Distance until some geometry is

clipped from view, and then gradually increase the distance until no clipping occurs.

Advanced: Environment tab

Click the Environment tab to set preferences for the environment lighting.

} Click to show/hide the parameters.

Parameter

Description

Ambient Color

Sets the color of ambient lighting—for example, to mimic sunrise or moonlighting.
Click the button next to the color definition. The Color Picker dialog box opens.

Choose a color from the color picker. The Preview displays the selected color. The




Hue, Saturation, and Luminance values display, as well as the Red, Green, and Blue

values.

Background Color

Sets the background color, if no Panoramic Background is specified. Click the
button next to the color definition. The Color Picker dialog box opens. Choose a
color from the color picker. The Preview displays the selected color. The Hue,
Saturation, and Luminance values display, as well as the Red, Green, and

Blue values.

Panoramic Background

The panoramic background is a composite of six images. These images are saved
individually but together form a “cube map.” When the component images are
properly named and aligned, as shown below, Vision renders them as a seamless

background image.

NOTE: The component images may need to be inverted or rotated for proper
alignment.

Each image must have the same name but with a special suffix denoting which side
of the cube it represents. All images must be saved in the same format, such

as .png or .jpg.

e  Front: Name_ft
e Back: Name_bk
e Left: Name_lIf

e Right: Name_rt
e Up: Name_up

e Down: Name_dn

Select one of the component images of your desired panoramic background; Vision
will locate the other images to form the cube map. Click the button to select an
image file; click X to remove the file.

Some panoramic backgrounds are provided with the Vision application; see the
“lo” .jpg files and “midnight-silence” .png files in the textures/App folder.




Sun Azimuth

Sets the azimuth for ambient lighting, when orbiting the ambient lighting around
the scene.

South is at 0 degrees, West is at 90 degrees, North is at 180 degrees, and East is at
270 degrees.

Sun Elevation

Sets the elevation (degrees above the horizon) for ambient lighting

Advanced: Haze tab

Click the Haze tab to set the haze preferences.

¥ Click to show/hide the parameters.

Parameter

Description

Haze Texture Style

Select the type of haze texture.
¢ No Texture: No haze texture is applied.
e Image-Based: Uses the specified Haze Texture image.

e 4D Procedurally-Generated: Uses a procedurally-generated texture that moves
in 3D space and time; performance may decrease.

Haze Texture

For a Haze Texture Style of Image-Based, select a haze image. The image is applied
where a light beam projects in the scene.

Haze Density

Controls the density of haze for all Haze Texture Style options. At 0%, white areas

of the texture have haze and black areas have none; at 100%, no texture is applied.

Haze Horizontal/Vertical Speed

Controls the speed of the haze as it moves horizontally and vertically

Haze Depth Speed

(4D Procedurally-Generated haze only)

Controls the speed of the haze as it moves forwards and backwards, relative to a

front view

Haze Turbulence

(4D Procedurally-Generated haze only)

Controls how fast the haze texture varies

Haze Horizontal/Vertical Offset

(Image-Based haze only)

Sets a horizontal or vertical offset for the haze image. The offset corresponds to
screen percentage; for example, an offset of 10% shifts the haze image by 10% of

the screen or Scene window.

Haze Contrast

(Image-Based haze only)

Controls the difference between light and dark pixels in the haze image

Haze Scale

Controls the size of the haze features. At large scale, the haze appears cloudy; at

small scale, many small wisps display in the light beam.




(4D Procedurally-Generated haze only)

Advanced: PSN tab

Click the PSN tab to set the PSN preferences.

¥ Click to show/hide the parameters.

Parameter

Description

PSN Axis Order

Determines which axes indicate right, up, and depth. PSN standards specify that X is right, Y is up, and Z is
depth.

PSN Rotation

Determines the multiplication order of the angles. PSN standards do not specify an axis rotation order, but in

Order Vision, the default order is set to YXZ.
PSN Position Enter the offset values for each axis; this is useful when the PSN server is sending a bad position value which
Offset X/Y/Z requires correction

PSN Rotation
Offset X/Y/Z

Enter the offset values for each axis; this is useful when the PSN server is sending a bad rotation value which
requires correction

PSN Unit Scale

Factor

PSN specifications use meters. Some PSN data may be in inches or millimeters or any other arbitrary unit of
data. If needed, the value entered here acts as a multiplier for PSN data values, so that the data work

properly in Vision.

Advanced: Bloom tab

Click the Bloom tab to set the bloom preferences.

¥ Click to show/hide the parameters.

Parameter

Description

Bloom Percentage

Sets the intensity of the bloom effect. This adds a glow to the brightest areas of the
scene, like a bright light overwhelming the camera or eye. A value of 0 (zero)
disables the bloom.

Bloom Threshold

Sets the lighting level where bloom occurs

Bloom Lens Strength Modifies the intensity of the bloom effect for lighting device lenses; at 0 (zero),

lenses are not rendered

Advanced: Heat Map tab

Click the Heat Map tab to set the heat map preferences.




¥ Click to show/hide the parameters.

Parameter

Description

Heat Map Style

Select the type of heat map to display.

None: Displays the normally rendered scene with no heat map.

Black and White: Displays a black and white heat map. This option sets the
Heat Map Min/Max Lux to the same threshold value. Black areas in the scene

have less illumination than this value. White areas have the same or more
illumination than this value.

NOTE: From the Properties palette, you can identify the lux value in a part of
the scene by scrolling to increase and decrease the threshold value; when a

part of the scene switches between black and white, its illumination matches
the threshold value.

Color Gradient: Displays a color heat map. Illumination is represented by a

blend of colors ranging from black as the Heat Map Min Lux to white as the
Heat Map Max Lux.

Minimum lux Heat map color scale Maximum lux

Heat Map Min Lux

Set the minimum lux value for the heat map

Heat Map Max Lux

Set the maximum lux value for the heat map

Preferences
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The DMX recorder




Editing the scene

Command Path Shortcut

Scene Graph | Window | e  Ctrl+Shift+R (Windows)
e Cmd+Shift+R (Mac)

The Scene Graph palette displays an organized list of scene items, including layers, objects, and fixtures (lighting devices and lasers).
Use the Scene Graph palette to select items in the scene, to select objects and fixtures for editing in the Properties palette, or to
select conventional lighting devices for fine adjustments in the Software Console palette. The Scene Graph palette’s context menu

provides options for organizing the scene contents, deleting items, replacing selected items, and troubleshooting display issues.

To open the Scene Graph palette:

Select the command.

The ROOT list heading, or "ROOT layer," represents the contents of the entire scene; it contains a hierarchical list of layers, scene

objects, and fixtures.

NOTE: Merged scene files display as layers under the ROOT layer (see Merging files).

Click successive disclosure arrows to navigate the scene hierarchy. Press the Alt key (Windows) or the Option key (Mac) when

clicking a disclosure arrow to expand or collapse all items in that layer.

Selected objects and fixtures are highlighted in the Scene window, and their parameters display in the Properties palette. When

multiple items are selected, the displayed parameters depend on the first item selected; only that type of item displays parameters.




Selecting global scene parameters, objects, and fixtures

To select items, you may need to expand the layers in the Scene Graph palette:

e From the Scene Graph palette, select ROOT to edit the global parameters for the entire scene (see Global parameters).

e Expand the ROOT layer to access items within the scene. Use the Page Up/Page Down and arrow keys to scroll through
the main ROOT layers. When a layer is selected, all items within the layer are also selected, so they can be moved and
transformed as a group. These items are highlighted in the Scene window, and their parameters display in the Properties
palette.

NOTE: Exact parameter values display only if they are identical for all items in the layer. When a value differs, this is

indicated by a double asterisk (**) after the parameter name, followed by a blank field or a value of 0.00.

e Keep expanding the layers until you access an individual fixture or object, to select and edit only a single item. The
selected fixture or object is highlighted in the Scene window, and its parameters display in the Properties palette.
Lighting devices with accessories may also display parameters for gobo images and shutters in the Software Console

palette. The displayed parameters depend on the lighting device type and accessories.

e Multiple items can be selected by pressing the Shift key or the Ctrl (Windows) or Cmd (Mac) key while clicking on items in
the Scene Graph palette.

Organizing the scene contents

Command

Insert Layer | Context menu

To organize the scene contents, insert new layers in the Scene Graph palette. You can drag and drop items from one layer to another.
When a layer is selected, all items contained in that layer are selected, so they can be moved and transformed as a group. This is

especially helpful when setting up DMX transforms.

To insert a layer in the Scene Graph palette:
Select an item in the list of scene contents, and select the command.
A new layer is inserted into the selected layer, or into the layer of the selected fixture or object.

NOTE: The layer can be renamed from the Properties palette.

To move a layer, click and drag it to the desired location. The ROOT layer is the highest level in the list of scene contents.

Correcting scene contents for previz

When objects are imported into Vision, they may need adjustment for correct display. The following commands apply only when

certain options are selected in the document preferences.



Adjusting the normals

Invert Normals Context menu

This command applies when Use Normals is selected on the Advanced: Rendering tab. If an object does not reflect light correctly,

its normals might be invalid. To view the normals, select Render Normals from the Advanced: Rendering tab.

e Left-facing normals are red.
e Top-facing normals are green.
¢  Front-facing normals are blue.

If an object’s normals are inverted, use the command to correct them.

To invert an object’s normals:

Select the object in the Scene Graph palette, and select the command.

Adjusting the winding order

Command

Flip Winding Order | Context menu

When Use Face Culling is selected on the Advanced: Rendering tab, Vision uses a clockwise winding order to render the scene

geometry. If any geometry displays incorrectly, its winding order might be incompatible.

NOTE: Winding (in a clockwise or counter-clockwise direction) defines the order of a polygon's vertices. The winding order
determines which polygons are facing the camera. When the scene geometry is wound in the same direction, face culling can

be used to render only the camera-facing geometry, for improved performance.

To reverse the winding order of one or more objects:

Select the object(s) in the Scene Graph palette, and select the command.

Refreshing the Scene Graph palette

Command Path

Refresh Context menu

You can refresh the Scene Graph palette to ensure the proper display of scene contents.

To refresh the Scene Graph palette:

Select the command.



The Scene Graph palette and the Properties palette are updated.

Deleting scene objects and fixtures

Replacing scene objects and fixtures

Opening files

Merging files
Preferences

The Properties palette

Assigning textures

Resetting video inputs

Modifying scene objects and fixtures

Focusing conventional lighting devices

The Software Console palette

Saving the scene as an image

Saving the scene as a movie

The Scene Graph palette

Command Shortcut

Scene Graph | Window | e  Ctrl+Shift+R (Windows)
e Cmd+Shift+R (Mac)

The Scene Graph palette displays an organized list of scene items, including layers, objects, and fixtures (lighting devices and lasers).
Use the Scene Graph palette to select items in the scene, to select objects and fixtures for editing in the Properties palette, or to
select conventional lighting devices for fine adjustments in the Software Console palette. The Scene Graph palette’s context menu

provides options for organizing the scene contents, deleting items, replacing selected items, and troubleshooting display issues.

To open the Scene Graph palette:

Select the command.

The ROOT list heading, or "ROOQT layer," represents the contents of the entire scene; it contains a hierarchical list of layers, scene

objects, and fixtures.

NOTE: Merged scene files display as layers under the ROOT layer (see Merging files).

Click successive disclosure arrows to navigate the scene hierarchy. Press the Alt key (Windows) or the Option key (Mac) when

clicking a disclosure arrow to expand or collapse all items in that layer.

Selected objects and fixtures are highlighted in the Scene window, and their parameters display in the Properties palette. When

multiple items are selected, the displayed parameters depend on the first item selected; only that type of item displays parameters.



Selecting global scene parameters, objects, and fixtures

To select items, you may need to expand the layers in the Scene Graph palette:

From the Scene Graph palette, select ROOT to edit the global parameters for the entire scene (see Global parameters).

Expand the ROOT layer to access items within the scene. Use the Page Up/Page Down and arrow keys to scroll through
the main ROOT layers. When a layer is selected, all items within the layer are also selected, so they can be moved and

transformed as a group. These items are highlighted in the Scene window, and their parameters display in the Properties
palette.

NOTE: Exact parameter values display only if they are identical for all items in the layer. When a value differs, this is
indicated by a double asterisk (**) after the parameter name, followed by a blank field or a value of 0.00.

Keep expanding the layers until you access an individual fixture or object, to select and edit only a single item. The
selected fixture or object is highlighted in the Scene window, and its parameters display in the Properties palette.
Lighting devices with accessories may also display parameters for gobo images and shutters in the Software Console
palette. The displayed parameters depend on the lighting device type and accessories.

Multiple items can be selected by pressing the Shift key or the Ctrl (Windows) or Cmd (Mac) key while clicking on items in
the Scene Graph palette.

Organizing the scene contents

Command

Insert Layer | Context menu




To organize the scene contents, insert new layers in the Scene Graph palette. You can drag and drop items from one layer to another.
When a layer is selected, all items contained in that layer are selected, so they can be moved and transformed as a group. This is
especially helpful when setting up DMX transforms.
To insert a layer in the Scene Graph palette:

Select an item in the list of scene contents, and select the command.

A new layer is inserted into the selected layer, or into the layer of the selected fixture or object.

NOTE: The layer can be renamed from the Properties palette.

To move a layer, click and drag it to the desired location. The ROOT layer is the highest level in the list of scene contents.

Correcting scene contents for previz

When objects are imported into Vision, they may need adjustment for correct display. The following commands apply only when

certain options are selected in the document preferences.

Adjusting the normals

Command

Invert Normals Context menu

This command applies when Use Normals is selected on the Advanced: Rendering tab. If an object does not reflect light correctly,
its normals might be invalid. To view the normals, select Render Normals from the Advanced: Rendering tab.

e Left-facing normals are red.
e Top-facing normals are green.
¢  Front-facing normals are blue.
If an object’s normals are inverted, use the command to correct them.

To invert an object’s normals:

Select the object in the Scene Graph palette, and select the command.

Adjusting the winding order

Command

Flip Winding Order | Context menu

When Use Face Culling is selected on the Advanced: Rendering tab, Vision uses a clockwise winding order to render the scene

geometry. If any geometry displays incorrectly, its winding order might be incompatible.



NOTE: Winding (in a clockwise or counter-clockwise direction) defines the order of a polygon's vertices. The winding order
determines which polygons are facing the camera. When the scene geometry is wound in the same direction, face culling can
be used to render only the camera-facing geometry, for improved performance.

To reverse the winding order of one or more objects:

Select the object(s) in the Scene Graph palette, and select the command.

Refreshing the Scene Graph palette

Command Path

Refresh Context menu

You can refresh the Scene Graph palette to ensure the proper display of scene contents.

To refresh the Scene Graph palette:

Select the command.

The Scene Graph palette and the Properties palette are updated.

Deleting scene objects and fixtures

Replacing scene objects and fixtures

Opening files
Merging files
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The Properties palette

Command Path Shortcut

Properties | Window | e  Ctrl+Shift+Y (Windows)
e Cmd+Shift+Y (Mac)

From the Properties palette, you can view and edit the parameters of selected fixtures, objects, or layers. The available parameters
depend on the items selected. Depending on the parameter, a field may be edited, a value toggled, or a dialog box opened.



NOTE: You can use the mouse wheel or arrow keys to change numerical parameter values by small increments; for larger
increments, use the Page Up/Page Down keys.

To open the Properties palette:

Select the command.

Individual parameters are categorized by function. Click the disclosure arrows to expand the categories. Press the Alt key (Windows)
or the Option key (Mac) when clicking a disclosure arrow to expand or collapse all items in that category.

Use the scroll bar on the Properties palette to navigate the list, or scroll with the Page Up/Page Down and arrow keys.

Properties
Property Value
= Multiple Selection (2 LIGHTING DEVICES)
Name**
Unit Number 0
Display Name High End Syste..
Manufacturer High End
Type Spot
Visible v True
Universe
Channel**
DMX Footprint
A double asterisk appended to the jiosiion
Position X and Position Z Position X** No double asterisk indicates that
parameters indicates that 0.00 is a [ R — 000is the exact Position Y

Position Z** value for both devices
~ Rotation

Rotation X

Rotation Y

Rotation Z
XForm Mode
-~ DMX XForm

placeholder for heterogeneous values

XForm Universe 0
XForm Channel (0]
XForm Delta X 0.00
XForm Delta Y 0.00
XForm Delta Z 0.00
XForm Rotation Axis None
XForm Rotation Delta 360.00

XForm Rotation Rpm 120
» PSN XForm

- Lighting
Candela Multiple "Multiple" means that, for each
Color Temperature ~ 6000.00 selected multi-part lighting
Force Emissive False device, the values differ for
Beam Multiplier Multiple different parts of the device
- MVR
UuID {00000000-0000
Invert Pan False
Invert Tilt False

Parameters for a multiple selection of multi-part lighting devices

When multiple items are selected, the exact parameter values display only if they are identical for all selected items. When a value

differs, this is indicated by a double asterisk (**) after the parameter name, followed by a blank field or a value of 0.00.



A parameter value of "Multiple" may display if one or more multi-part lighting devices are selected. "Multiple" indicates that the
parameter value is not identical for all parts of the lighting device.

Global parameters

When no scene items are currently selected, the global scene parameters display in the Properties palette. To edit these parameters,

select ROOT from the Scene Graph palette. The global parameters can also be edited from the Document Preferences dialog box.

The global parameters that display in the Properties palette depend on whether the document preferences are shown in Basic or

Advanced mode. If Basic mode is active, the global parameters match the Basic document preferences. If Advanced mode is active,

the global parameters match the Advanced document preferences.

» Click to show/hide the parameters.

Global parameter Description

Globals See Basic document preferences or Advanced document preferences for parameter

descriptions

High Precision Enables highly accurate renderings. Deselect the check box to quickly render large files;
the check box must be deselected each time you open a .v3s file. Some artifacts may

appear.

NOTE: Use this setting primarily for testing.

Object and fixture parameters

The parameters that display in the Properties palette depend on the type of items selected. Some parameters are available for both
objects and fixtures (lighting devices, projectors, and lasers), while others are available exclusively for objects, lighting devices,
projectors, or lasers. Some of these parameters are also available for layers in the Scene Graph palette (for more information on
layers, see Organizing the scene contents).

» Click to show/hide the parameters.

Parameter Description Availability

Name Displays the lighting device's channel number or the name of the Objects, fixtures, and
laser, projector, object, or layer layers

Unit Number Displays the fixture's unit number Fixtures

Display Name Displays the fixture's make and model; this field cannot be edited Fixtures

Manufacturer Displays the fixture manufacturer; this field cannot be edited Fixtures

Type Displays the fixture type; this field cannot be edited Fixtures




Visible

Indicates that the fixture is visible in the scene; deselect to make the

fixture invisible

Fixures and layers

Fixture Number

Displays the fixture number corresponding to the laser projection
zone configuration selected in the Pangolin BEYOND® software

Lasers

Universe Displays the universe assigned to the lighting device or projector Lighting devices,
projectors
Channel Displays the DMX address assigned to the lighting device or projector Lighting devices,

projectors

DMX Footprint

Displays the number of control channels used by the lighting device or

projector; this field cannot be edited

Lighting devices,

projectors

Cast Shadows Controls the display of shadows for specific objects and layers, so you Objects and layers
can override the global shadow preference when needed.
NOTE: Set the global shadow behavior from the Render
shadows setting on the Basic: Graphics tab or Advanced:
Graphics tab.
e Use Parent Setting: Uses the same Cast shadows setting that is
specified for the closest "parent" layer in the Scene Graph
palette. This option is selected for all objects and layers by
default, so the ROQOT layer setting (controlled by the Render
shadows preference) is applied globally.
e Cast Shadows: Toggles shadows on, even when you deselect the
Render shadows preference.
e Do Not Cast Shadows: Toggles shadows off, even when you select
the Render shadows preference.
Position Objects, fixtures, and
layers
Position X Sets the item's position on the X axis in inches. Positive values move Objects, fixtures, and
right; negative values move left. layers
Position Y Sets the item's position on the Y axis in inches. Positive values move Objects, fixtures, and
up; negative values move down. layers
Position Z Sets the item's position on the Z axis in inches. Positive values move Objects, fixtures, and
away from the camera; negative values move toward it. layers
Rotation Objects, fixtures, and

layers




Rotation X/Y/Z

Sets the item's rotation on the X/Y/Z axis in inches. Positive values

rotate clockwise; negative values rotate counter-clockwise.

Objects, fixtures, and
layers

Scale Objects and layers
Scale X/Y/Z Sets the scale of the object in its local X-/Y-/Z-axis coordinate direction Objects and layers
XForm Mode Sets the type of transforms: DMX, PSN, or None. Objects, fixtures, and
layers
NOTE: Select None when you want to keep the transform
parameters configured, but temporarily disabled.
DMX XForm Moves, rotates, and scales selected items in the scene, or all items in Objects, fixtures, and
the selected layer. See DMX transforms for more information. layers
NOTE: Lighting devices cannot be scaled by DMX transform.
PSN XForm Moves and rotates selected items in the scene, or all items in the Objects, fixtures, and
selected layer. See PSN transforms for more information. layers
Material Objects
Color Displays the RGB color assigned to the object Objects
Texture Displays the image file, video file, or video input assigned to the Objects
object. Click the button next to the texture field to select a file. Click
X to remove the file.
For more information on adding video to textures, see Assigning
textures.
Use Alpha Channel Uses the alpha channel from the Texture as the rendering mask Objects
Texture Scale Sets the texture size on an object. For example, a scale value of 2 Objects
doubles the size of the texture.
Texture Offset H/V Shifts the start location of the texture horizontally or vertically Objects
Brightness Controls the brightness of the texture by adjusting the comparative Objects
luminance of each pixel in the texture image; this is useful for video
screens
Specular Texture Uses a color image to control the color and intensity of the object's Objects

reflectivity, depending on the amount of surface detail and the
Specular Power. Click the button next to the texture field to select a
texture image file. Click X to remove the file.




Specular Power Controls the sharpness of the object's highlights and environment Objects
reflections. Lower values create blurry reflections (good for carpet),
while higher values create sharper reflections (good for metal).
Normal Texture Uses a color image to simulate the lighting of small surface Objects
irregularities. RGB colors on the object surface correspond to XYZ
values, to indicate the direction that light reflects off the object. Click
the button next to the texture field to select a texture image file. Click
X to remove the file.
NOTE: Vision uses tangent space normal maps.
Bump Texture Uses a grayscale image to simulate surface contours, such as brick Objects
work, for an embossed appearance. Bump textures can provide a
greater sense of depth than normal textures, but performance may
decrease. Click the button next to the texture field to select a texture
image file. Click X to remove the file.
Alpha Texture Uses an image mask to simulate surface transparency or opacity. Objects
White areas appear opaque and black areas appear transparent. Click
the button next to the texture field to select a texture image file. Click
X to remove the file.
Force Emissive Makes a texture image glow even when the ambient lighting is low. Objects
Mesh This is a good setting for video screens and LED tape.
Emissive Objects
Lighting Device Type [ Converts geometry into a DMX-controlled emissive lighting device, Objects
such as a glowing sphere. The brightness of RGB colors is controlled
by separate channels.
Lighting Device Sets the maximum output of the emissive lighting device, controlling Objects
Candela how brightly it glows
Lighting Device Displays the universe assigned to the emissive lighting device Objects
Universe
Lighting Device Displays the channel assigned to the emissive lighting device Objects
Channel
Lighting Lighting devices,

projectors




Candela

Sets the maximum output of the lamp. Increase the value to make
both the beam and the surface lights brighter.

NOTE: Perceived brightness also depends on the beam and field
angles of the lighting device, the dimmer, and other components
of the light train.

Lighting devices,
projectors

Color Temperature

Sets the temperature of emitted light. At 6000K, the light appears
white. Larger values make the light appear cooler (blue), and smaller
values make the light appear warmer (amber).

Lighting devices,
projectors

Force Emissive

Converts the lighting device to an emissive; the lens glows, but the
lighting device does not emit beams, create surface lights, or cast
shadows. This is a good setting for blinders, LED lighting devices, and
performance-intensive multi-part lighting devices. (Although you can

use this parameter for projectors, this would be unusual.)

NOTE: Emissive lighting devices can significantly improve

performance.

Lighting devices,

projectors

Beam Multiplier

Multiplies the brightness of the beam without affecting surface lights.

NOTE: This is not a real-world fix; adjust the beam by other

parameters if possible.

Lighting devices,

projectors

Gobo Wheels

Select a gobo image for the lighting device to project. Click the button
next to the slot number to select the image file for the slot. Click X to

remove the file.

Lighting devices

Color Wheels

Select a color for each slot in the lighting device's color wheel. Click
the button next to the color definition. The Color Picker dialog box
opens. Color libraries from common manufacturers are listed in the
Number column. Expand the list by clicking the disclosure arrows.
Select a standard color from a manufacturer, or choose a color from
the color picker. The Preview displays the selected color. The Hue,
Saturation, and Luminance values, as well as the Red, Green, and

Blue values, display.

Lighting devices

Projection

Projectors

Source Input

Select a file for the projector; click X to remove the file.

Alternatively, right-click on a projector and select Assign Video Input,
or Reset Video Input to select a different video source.

Projectors

Test Image

Temporarily projects an image to assist with setting up the projector

Projectors

Floor Mounted

Determines whether the projector is floor mounted or attached to the
ceiling

Projectors




Auto Aspect Ratio Matches the projector's aspect ratio to the source Projectors

Aspect Ratio Forces the projected video to the specified aspect ratio Projectors

Keystoning A keystoning workflow allows you to properly adjust the projected Projectors
image to the borders of the screen surface by temporarily

manipulating the output light and shape.

See Keystoning to set the projector image on the surface.

Keystone Color Select the color to use while keystoning Projectors

Keystone Mode Select the keystone workflow: Projectors
¢ None: Turns off keystoning
e Vertical: For simple keystoning cases, select this option

e Four corner: Opens the Four Corner Keystone dialog box, for

advanced keystoning by drag-and-drop

Vertical Keystone Specify the vertical keystoning value Projectors

(Vertical Keystone

Mode)
MVR Objects, fixtures, and
layers
(MVR only)
UulID Displays the item's unique ID for tracking by MVR; see Merging files Objects, fixtures, and
layers
(MVR only)
Invert Pan Inverts the lighting device's pan Lighting devices
Invert Tilt Inverts the lighting device's tilt Lighting devices

Modifying scene objects and fixtures

Preferences
DMX transforms

Focusing conventional lighting devices

PSN transforms

PosiStageNet (PSN) is an open source protocol that allows both pre-programming and active control of object (or layer) movement

and rotation. PSN data originates from the PSN server; a unique identifier, called a PSN Tracker ID, must be identical in Vision and on



the PSN server. When Vision sees PSN server data on the network that matches the PSN Tracker ID for an object or layer, the PSN
data is applied in Vision and the object or layer rotates and/or moves.

PSN must be enabled on the Session tab of the Vision Preferences dialog box for PSN server data to be detected.

Use PSN transforms to rotate and move selected items in the scene. PSN can perform rotations simultaneously on the X, Y, and Z
axes. Movement is independent from the object’s rotation. To account for occasional inaccuracies in the PSN data, there are
several PSN position parameters. For example, you may need to add an offset along one axis to position the object correctly in
Vision after it receives the data from the PSN server.

To transform objects in PSN mode:

1. Select one or more lighting devices or objects.

To transform multiple selections at once, you can group them in a layer; see Organizing the scene contents. When a layer

is transformed, all items contained in that layer are transformed accordingly. A transformed lighting device's pan and tilt
are relative to the transformed position.

NOTE: To significantly improve performance for PSN transforms, disable shadows from the Basic: Graphics tab or

Advanced: Graphics tab. If shadows are needed, set Dynamic Shadows to None from the Advanced: Graphics tab;

shadows will be disabled only for transformed objects.
2. Inthe Properties palette, select PSN for the Xform Mode.

3. Obtain a unique PSN Tracker ID for the object or layer from the PSN server. (When PSN is enabled in the Session
preferences, the server is configured to send out an identifier to associate the object/layer with PSN data.)

When the PSN Tracker ID in Vision matches the one on the PSN server, the server sends positional and rotational data to
the object, which moves and/or rotates the object in Vision. No further configuration of the parameters is necessary,
unless there is an issue with the data that requires correction in Vision for the proper rotation. If so, adjust the values as
needed.

NOTE: If you have entered default data in the document preferences, select Use Document Setting to use the
default for any of the applicable PSN parameters.

¥ Click to show/hide the parameters.

Parameter Description
XForm Mode Select PSN to enable PSN transforms
PSN XForm Expand the PSN XForm heading to access the parameters

PSN Tracker ID Enter the unique PSN Tracker ID for the object or layer from the PSN server

PSN Select whether to use world or local (relative) coordinates. World coordinates ignore all object position and
Coordinates rotation fields for the object and all of its parents, using only the PSN data sent from the server. Local

coordinates apply the object and all of its parent's position and rotation values, in addition to the PSN data.




PSN Axis Order If the default is not correct in Vision, select the PSN Axis Order. This determines which axes indicate right, up,
and depth. PSN standards specify that X is right, Y is up, and Z is depth.

PSN Rotation If the default is not correct in Vision, select the PSN Rotation Order, which determines the multiplication order
Order of the angles. PSN standards do not specify an axis rotation order, but in Vision, the default order is set to YXZ.
PSN Offset
PSN Enter the PSN Position Offset values for each axis; this is useful when the origin of the Vision file does not align
Position with the origin on the the PSN server.
Offset
PSN Enter the PSN Rotation Offset values for each axis; this is useful when the PSN server is sending a bad rotational
Rotation value which requires correction
Offset
PSN Unit Scale PSN specifications use meters. Some PSN data may be in inches or millimeters or any other arbitrary unit of
Factor data. If needed, enter a value in PSN Unit Scale Factor to act as a multiplier for PSN data values, so that the data

work properly in Vision.

Enable PSN Select the axes that will participate in the object's movement, and deselect an axis that should ignore positional

Position data. The movement is not affected by the item’s rotation. The direction is relative to the selected coordinate
space.

Enable PSN Select the axes that will participate in the object's rotation, and deselect an axis that should ignore rotational

Rotation data. The rotation is relative to the selected coordinate space.

The Scene Graph palette

Preferences

Setting document preferences

Modifying scene objects and fixtures

DMX transforms

DMX transforms

Use DMX transforms to scale, rotate, and move selected items in the scene. Scaling and movement are independent from the

object’s rotation. Scaling does not apply to lighting devices.

To transform objects in DMX mode:
1. Select one or more lighting devices or objects.

To transform multiple selections at once, you can group them in a layer; see Organizing the scene contents. When a layer

is transformed, all items contained in that layer are transformed accordingly. A transformed lighting device's pan and tilt

are relative to the transformed position.




NOTE: To significantly improve performance for DMX transforms, disable shadows from the Basic: Graphics tab or
Advanced: Graphics tab. If shadows are needed, set Dynamic Shadows to None from the Advanced: Graphics tab;

shadows will be disabled only for transformed objects.
2. Inthe Properties palette, select DMX for the Xform Mode.

3. Scale, move, and/or rotate the selected objects using the DMX XForm parameters.

¥ Click to show/hide parameters.

Parameter Description

XForm Mode Select DMX to enable DMX transforms

DMX XForm Expand the DMX XForm heading to access the parameters
XForm Universe Enter the universe
XForm Channel Enter the DMX address
XForm Delta X/ Enter the XForm Delta values (in inches) to specify the direction and magnitude of movement. The
XForm Delta Y/ movement is not affected by the item’s rotation. The direction is relative to the item’s local coordinate
XForm Delta Z space.

e Delta X controls the range of lateral movement.

e DeltaY controls the range of upward/downward movement.

e Delta Z controls the range of forward/backward movement.
NOTE: The Position X/Y/Z values in the Properties palette determine the selected items’ starting
position.

Set the DMX profile for the desired movement.

NOTE: 50% indicates the center of the range of movement.

Channel Coarse/Fine Purpose %: Function

1 Coarse XForm Delta X | 0—100: X axis movement
2 Fine

3 Coarse XForm DeltaY | 0—100:Y axis movement
4 Fine

5 Coarse XForm DeltaZ | 0—100: Z axis movement
6 Fine




XForm Rotation
Axis

Select the rotation axis, or select None.

Set the DMX profile for rotation.

NOTE: Rotation occurs around the local origin, not the world origin.

Channel Coarse/Fine Purpose %: Function

7 Coarse XForm Rotation (Index) 0-100: Rotation

8 Fine

7 Coarse XForm Rotation (Continuous) e 0-0: No rotation
e 48 -—1: Clockwise rotation

8 Fine e 49-51: No rotation
e 52 -99: Counter-clockwise rotation
e 100-100: No rotation

9 XForm Rotation Control e 0-20: Index rotation

e 21 -40: Continuous rotation
e 41-100: Reserved

There are three “dead zones” where no rotation occurs in the Continuous Rotation channel: 0%,

49-51%, and 100%. The rotation is clockwise at 48—1% (where the effect increases as DMX value

decreases) and counter-clockwise at 52-99%.

XForm Rotation
Delta

Sets the maximum angle of index rotation

XForm Rotation
Rpm

Set the maximum speed of continuous rotation

XForm Scale X/
XForm Scale Y/
XForm Scale Z

Enter scale factors for each axis to scale the selected object along that axis. Scaling is not affected by

the object’s rotation.

Set the DMX profile for scaling.

Channel Coarse/Fine Purpose %: Function
10 Coarse XForm Scale X | 0—100

11 Fine

12 Coarse XForm ScaleY | 0-100

13 Fine

14 Coarse XForm ScaleZ | 0-100




15 Fine ‘ ‘

PSN transforms
Preferences

Modifying scene objects and fixtures

Assigning textures

Textures can display images or video from a file, or live streams from a video input.
In Vectorworks, the Vision video source can be specified with the Spotlight > Visualization > Select Vision Video Source command,

or from the properties of a video screen. In the Vectorworks online help system, see “Identifying a Video Source for the Vision

Program” for more information.

Assigning image or video files

To assign an image or video file to a texture:
1. Select one or more objects, and then click the button next to the Texture field on the Properties palette.
2. Navigate to the image or video file and select it.

The content displays on the selected objects. If a video file is selected, the video plays immediately and loops indefinitely.

To remove the texture file, click X next to the Texture field.

Assigning video inputs

Textures can display different types of video input, including capture cards and Network Device Interface (NDI®) protocol.

NOTE: The number of NDI® inputs that can display in the scene depends on your Vision license. If more inputs are assigned than
your license allows, the associated textures are rendered as black.

The Scene window status bar indicates the status of certain input types, such as the status of all NDI® inputs that are assigned to

textures.

o n None: No video inputs of this type are assigned.
o . Good: All assigned video inputs are available.

. E Partial: Some of the assigned video inputs are unavailable.

o . Bad: No assigned video inputs are available.



For these types of video input, the status of individual inputs is indicated in the Select Video Input dialog box.

To assign a video input to a texture:
1. With one or more objects selected, do one of the following:

e Right-click in the viewport and select Assign Video Input from the context menu. From the Assign Video Input dialog
box, specify a name for the texture. If the specified texture already has an assigned video input, the video displays on
the selected objects. If a new name is entered, proceed to step 2.

e Click the button next to the Texture field on the Properties palette. Navigate to textures\App within the Vision folder,
and select a capture file. Ten .cap files are provided, and more can be created as needed. If the .cap file already has
an assigned video input, the video displays on the selected objects. If the .cap file is unused, proceed to step 2.

2. The Select Video Input dialog box opens. All scene objects with the selected texture display a checkerboard pattern for
identification. Proceed to step 5 if not cropping the video input.

¥ Click to show/hide the parameters.

Parameter Description

Video input list Lists all available video inputs with a prefix indicating the type. The status is
displayed for certain types, such as NDI®.

o . Good: The video input is available.
o . Bad: The video input is unavailable.

The status icon updates automatically when the status changes.

Crop Video Input Crops the video input for display. Different portions of the same input can display
on different objects, creating a split-screen effect.

Delete Cropped Video Input Removes the selected video input from the list
Preview Displays a preview of the selected video input and its resolution
Options Options display for certain types of input. You can set the bandwidth for NDI®

inputs. For best performance, select Low Bandwidth.

3. Select Crop Video Input to define the area of the video input that displays.

The Crop Video Input dialog box opens.

4. Either enter the right, left, top, and bottom coordinates of the desired area, or use the handles on the preview to

position the video. Click OK to return to the Select Video Input dialog box.

The video crop displays, and shows its coordinates, in the list of available inputs.

5. Select a video input, and click OK.



The video displays on the selected objects.

To remove the assigned texture, click X next to the Texture field.

The Scene Graph palette
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Modifying video inputs

Resetting video inputs

Managing assigned video inputs

Modifying video inputs

Command

Modify Video Input | Viewport context menu

Certain types of video input (video input associated with textures) have options for their modification.

To modify a video input:
1. Select an object with the texture input to modify, and select the command.
The Modify Video Input dialog box opens.

} Click to show/hide the parameters.

Parameter Description

Preview Displays a preview of the video input and its resolution

Low/High Bandwidth Sets the video bandwidth. Select Low Bandwidth for best performance.
(NDI® only)

2. Select the desired options.

All objects with the selected texture display the modified input.

The Scene Graph palette

Assigning textures

Resetting video inputs

Managing assigned video inputs

Resetting video inputs

You can reset one or more video inputs, to change the inputs assigned to textures.



Resetting a single video input

Command

Reset Video Input | Viewport context menu

To reset a video input:

1. Select an object with the texture input to change, and select the command. All objects with the selected texture display a

checkerboard pattern for identification.

The Select Video Input dialog box opens.

2. Select a video input for the specified texture, as described in Assigning video inputs.

All objects with the selected texture display the new input.

Resetting multiple video inputs

Command

Reset Video Inputs | Render

To reset one or more video inputs:

1. Select the command.

NOTE: An alert indicates the status of video inputs in the file. If all inputs are available, click OK. If some inputs are

faulty, address the issues as described in Managing assigned video inputs.

The Select Video Input Texture dialog box opens, listing the textures in use.

2. Select a texture to change; Preview displays the assigned video input. All scene objects with the selected texture display

a checkerboard pattern for identification.

3. Click Reset.

The Select Video Input dialog box opens.

4. Select a video input for the specified texture, as described in Assigning video inputs.

All objects with the selected texture display the new input.

5. You are prompted to reset more video inputs. Click Yes to continue changing inputs, or click No to stop.

The Scene Graph palette

Assigning textures
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Managing assigned video inputs

Managing assigned video inputs

Video input assignments and crops are saved with the scene file. As described in Assigning video inputs, the Scene window status
bar displays the current status of certain input types. If any assigned inputs are unavailable when the file is opened, a diagnostic
alert indicates the faulty inputs. Vision will continue searching for these inputs while the alert is open.

If assigned inputs are unavailable, do one of the following:

¢ Fix the connectivity issues: As faulty inputs are fixed, their status updates automatically in the diagnostic alert, which
closes when all inputs are found. Click OK in the success alert.

e Assign a different video input: Click Cancel in the diagnostic alert. The Select Video Input dialog box opens to specify new
inputs for the associated textures; see Assigning video inputs.

e Work without video inputs: Click Cancel in the diagnostic alert, and then click Cancel in the Select Video Input dialog box.
The textures that are associated with unavailable inputs are rendered as black. If you choose to work without video
inputs, the saved inputs can be restored mid-session.

NOTE: Capture cards must be plugged in when Vision is launched.

To restore assigned video inputs:

1. Select Render > Restore Video Inputs.

2. Analert displays the status of video inputs in the file.

e If faulty inputs remain, they are indicated for troubleshooting. Fix the connectivity issues.

e When all assigned inputs are available, click OK; the inputs automatically display on the associated textures.

The Scene Graph palette
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Modifying video inputs

Resetting video inputs

Rendering video with Disguise EVO

Rendering video with Disguise EVO

Vision can integrate with Disguise EVO® for synchronized visualization of lighting and video. The integration uses DMX-controlled
cameras and an exchange of NDI® streams to sync the two programs. This allows Disguise to render video for Vision and control its
camera movement.

To enable the integration with Disguise:



Activate and patch the Disguise camera as described in DMX control of the Disguise camera. Vision turns off the video

rendering and outputs a live stream of the viewport for Disguise to receive.

To disable the integration with Disguise:
1. Deselect Disguise Camera in the DMX controls dialog box.
2. Click Yes when prompted to stop sending a live NDI® stream of Vision and to turn on video rendering.

Video rendering is turned on in Vision. Disguise no longer renders the video.

Using DMX controls

Setting document preferences

Adding scene objects

Adding lighting devices

Tool set

Lighting Device | Modify Scene

The Lighting Device tool adds lighting devices to the scene.

NOTE: This tool inserts Vision lighting devices, not GDTF lighting devices.

To add a lighting device to the scene:
1. Click the tool.
The Lighting Device dialog box opens.
2. Select the lighting device to insert, and set the parameters.

} Click to show/hide the parameters.

Parameter Description

Fixture Mode Lists the available lighting devices. The devices can be listed in different ways; click the

disclosure arrow to expand the category.

e All: Lists all lighting devices alphabetically by name.
e Manufacturer: Lists all lighting devices alphabetically by manufacturer name.

e Type: Lists all lighting devices alphabetically by type.

Click on the column heading to sort the list in ascending or descending order.




DMX Footprint Displays the number of control channels used by the lighting device. Click on the column
heading to sort the list in ascending or descending order.

Search Enter a search term, and click Search. Only lighting devices that contain the search term
display in the list; click the disclosure arrow to expand the list.

Universe Enter the universe number assigned to the lighting device
Channel Enter the channel number assigned to the lighting device
Trim Height Specify the height of the lighting device above the zero plane

3. Click in the Scene window to insert the lighting device.

The lighting device properties can be edited from The Properties palette.

Adding objects
Adding projectors
Adding lasers

The application window

The Scene Graph palette

Replacing scene objects and fixtures

Deleting scene objects and fixtures

Adding projectors

Tool set

Projector | Modify Scene

The Projector tool adds a projector to the scene.

¢ Inasimple model, insert a projector and a video screen. Check the model, projector beams, and appearance of the video

on the screen to ensure nothing is obstructing a proper projection to the designated screen.

e An advanced workflow might involve leveraging Vision’s heat map feature to perform a projector study, where multiple

projectors are blended together on the media server side to appear as a single large projection surface.
NOTE: This tool inserts Vision projectors, not GDTF projectors.
To add a projector to the scene:

1. Click the tool.



The Projectors dialog box opens.
2. Select the projector to insert, and set the parameters.

¥ Click to show/hide the parameters.

Parameter Description

Fixture Mode Lists the available projectors. The devices can be listed in different ways; click the disclosure
arrow to expand the category.

e All: Lists all lighting devices alphabetically by name.
e Manufacturer: Lists all lighting devices alphabetically by manufacturer name.

Click on the column heading to sort the list in ascending or descending order.

DMX Footprint Displays the number of control channels used by the projector. Click on the column heading to

sort the list in ascending or descending order.

Search Enter a search term, and click Search. Only projectors that contain the search term display in the

list; click the disclosure arrow to expand the list.

Universe Enter the universe number assigned to the projector
Channel Enter the channel number assigned to the projector
Trim Height Specify the height of the projector above the zero plane

3. Click in the Scene window to insert the projector.

The Assign Video Input dialog box opens.

4. Provide a Name for the video input.

The Select Video Input dialog box opens.

5. Do one of the following:

e Associate a video source, such as an NDI stream or UVC source, with the projector. See Assigning video inputs for

more information.

e Click Cancel to assign a video source or a static image to the projector later from the Properties palette.

The projector properties can be edited from The Properties palette.

Keystoning to set the projector image on the surface

Use the keystoning method to manipulate the light output for a proper projection onto a surface. Keystoning ensures the output
aligns properly with the screen. Use a vertical keystone for simple situations; for complex situations that require more adjustments,

use the four corner method.



To use keystoning for the projector:
1. Select the projector. Assign a source with the Source Input, or select a Test Image.

2. Inthe Properties palette, select a Keystone Color. Choose a bright color that contrasts with the source video or test
image.

3. Do one of the following:

e If the video only requires slight adjustment vertically, select the Vertical Keystone Mode. Enter a value in Vertical

Keystone to adjust the video; the projection adjusts in real time.

For drag-and-drop keystone adjustments, select Four Corner Keystone Mode (alternatively, right-click on the
projector and select Four Corner Keystone). The Four Corner Keystone dialog box opens; move the dialog box to be
able to see the projection screen surface, which adjusts in real time. Drag each corner of the keystone shape to

adjust the image or video to properly fit the screen. If needed, click Reset Keystone to return the handles to their
default positions.
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4. Return the Keystone Color to (0, 0, 0).

Adding lasers
Adding objects
Adding lighting devices

The application window

The Scene Graph palette

Replacing scene objects and fixtures

Deleting scene objects and fixtures

Adding lasers

Tool set

Laser Modify Scene

The Laser tool adds a laser to the scene, so you can stream laser show content from the Pangolin BEYOND® software. Laser beam

shows rely on the haze settings in the Preferences.

NOTE: Lasers are supported in .vsn files only.

To add a laser to the scene:

1. Click the tool.

The Laser dialog box opens.


file:/C:/Users/JulieD/Documents/Manuel/Manuel%202024%20EN/Vision/RoboHelp/PDF/FourCornerKeystone.mp4

2. Select the laser to insert, and set the parameters.

¥ Click to show/hide the parameters.

Parameter Description

Laser list Lists the available lasers. The lasers can be listed in different ways; click the disclosure arrow to expand the
category.
e All: Lists all lasers alphabetically by name.
e Manufacturer: Lists all lasers alphabetically by manufacturer name.
Click on the column heading to sort the list in ascending or descending order.

Search Enter a search term, and click Search. Only lasers that contain the search term display in the list; click the disclosure
arrow to expand the list.

Fixture Specify the fixture number for the projection zone configuration selected in BEYOND

Number

Trim Height Specify the height of the laser above the zero plane

3. Click in the Scene window to insert the laser.

The laser properties can be edited from The Properties palette.

Adding lighting devices
Adding projectors

Adding objects
The application window

The Scene Graph palette

Replacing scene objects and fixtures

Deleting scene objects and fixtures

Adding objects

Tool set

Modify Scene

The Object

Toadd ano

tool adds objects to the scene.

bject to the scene:

1. Click the tool.




The Object dialog box opens.
2. Select the object to insert, and set the parameters.

¥ Click to show/hide the parameters.

Parameter Description

Object list Select an object for insertion. The available objects are listed alphabetically by category; click
the disclosure arrow to expand the list.

Filter Enter a search term, and click Search. Only objects that contain the search term are displayed
in the Search Results list.

Trim Height Specify the height of the object above the zero plane

Rotation Specify the rotation angle of the object

3. Click in the Scene window to insert the object.

The Modify Scene tool set contains additional tools to insert simple primitive objects, such as spheres or lines.

To insert a simple object into the scene:
1. Click the Sphere, Box, or Cylinder tool.

2. Click in the Scene window. Drag the mouse to draw the object, and release the mouse when the object has the desired
scale. Lines are drawn by clicking, dragging, and clicking again to finish the line.

The object properties can be edited from The Properties palette.

Adding lighting devices
Adding projectors

Adding lasers
The application window

The Scene Graph palette

Replacing scene objects and fixtures

Deleting scene objects and fixtures




Modifying scene objects

Modifying scene objects and fixtures

Selecting geometry

Tool Tool set Shortcut

Select | Select X

The Select tool selects an object or fixture (lighting device or laser) in the Scene window. The selected item is also selected in the

Scene Graph palette, and its parameters display in the Properties palette.

NOTE: If nothing is selected in the Scene window, the ROOT layer is selected in the Scene Graph palette, and the global scene

parameters are displayed.

To select an object or fixture:
1. Click the tool.

2. Click an item in the Scene window. A bounding box displays around the selected item. If a laser is selected, its scan area is

highlighted in the scene. If a lighting device is selected, it outputs light.

Alternatively, select one or more items from the Scene Graph palette.

Multiple objects and fixtures can be selected by pressing the Ctrl (Windows) or Cmd (Mac) key while clicking on items in the Scene

window.

Moving geometry

There are several ways to move objects and fixtures in the scene. The Move tool is best for approximate movements. For exact

movements, do one of the following:

e To move a single item—or multiple items of the same type—to a specific coordinate position, enter the Position X/Y/Z

value in the Properties palette.
¢ To move items of any type by an exact distance, use the Move 3D command to move the items along the selected axis.

e To move items by DMX input, see DMX transforms.
Moving geometry by dragging

Tool Tool set



Move Modify Object

To move objects and fixtures by dragging:

1. Click the tool.

2. Click one or more items in the Scene window and drag them to the desired location.

Moving geometry by command

Command Path Shortcut

Move 3D Edit e  Ctrl+M (Windows)
e Cmd+M (Mac)

Use the Move 3D command to move an object or fixture relative to its current position. You can also move multiple items by the
same distance value. For example, select trusses with different trim heights and raise them all by 12 inches.

To move objects and fixtures by a specified distance:
1. Select the items to move.
2. Select the command.
The Move 3D dialog box opens.

} Click to show/hide the parameters.

Parameter Description
X/Y/Z Axis Select the axis of movement
Distance Specify the distance to move (in inches)

The selected items move accordingly.

Rotating geometry

There are several ways to rotate objects and fixtures in the scene. The Rotate tool is best for approximate rotations. For exact
rotations, do one of the following:

¢ To rotate a single item—or multiple items of the same type—to a specific angle, enter the Rotation X/Y/Z value in the
Properties palette.



e To rotate items of any type by a specified number of degrees, use the Rotate 3D command to rotate the items along the

selected axis.

e To rotate items by DMX input, see DMX transforms.

Rotating geometry by dragging

Tool set

Rotate | Modify Object

A

)

To rotate objects and fixtures by dragging:
1. Click the tool.

2. Click one or more items in the Scene window and change their rotation angle by dragging with the mouse.

Rotating geometry by command

Command Path

Rotate 3D Edit

Use the Rotate 3D command to rotate an object or fixture relative to its current orientation. You can also rotate multiple items by

the same degree value. For example, to flip a selection of fixtures, adjust the rotation by 180 degrees.

To rotate objects and fixtures by a specified number of degrees:
1. Select the items to rotate.
2. Select the command.
The Rotate 3D dialog box opens.

¥ Click to show/hide the parameters.

Parameter Description
X/Y/Z Axis Select the axis of rotation
Rotation Angle Specify the angle of rotation

The selected items are rotated accordingly.



Resizing geometry

Tool Tool set

Scale Modify Object

The Scale tool changes the scale of an object or fixture in the Scene window.

To resize an object or fixture:
1. Click the tool.
2. Click on the item in the Scene window and scale it up or down by dragging with the mouse.

Alternatively, change the scale of the selected item from the Properties palette.

The application window

The Scene Graph palette

Replacing scene objects and fixtures
Deleting scene objects and fixtures

Replacing scene objects and fixtures

Command Path

e Replace Selected with > Lasers Context menu

e Replace Selected with > Lighting Devices
e Replace Selected with > Projectors

e Replace Selected > All with

e Replace Selected > Lasers with

e Replace Selected > Lighting Devices with

e Replace Selected > Projectors with

You can replace selected scene objects, fixtures, and projectors with lighting devices, lasers, or projectors.

NOTE: This is a good way of replacing lasers or projectors that were exported from Vectorworks through MVR, with Vision lasers

or projectors which have advanced features.

A variety of replacement situations can occur depending upon the selection:

e If the selection contains only one type of item, replace the selection with lighting devices, lasers, or projectors.



¢ If a mix of object types is selected, the appropriate command will determine which objects will be replaced and what will
replace them.

NOTE: You cannot replace a Vision lighting device with a GDTF lighting device, or replace a GDTF lighting device with a Vision
lighting device. To edit GDTF lighting devices, see Updating GDTF fixtures.

To replace scene objects:
1. Select the objects to replace.
Do one of the following:

e From the Scene Graph palette, select the object, lighting device, projector, and/or laser to replace. Multiple objects
can be selected by selecting a layer, or by pressing the Shift key or the Ctrl key (Windows) or Cmd key (Mac) while
clicking on the objects.

¢ From the Scene window, select the object, lighting device, projector, and/or laser to replace. Multiple objects can be
selected by pressing the Ctrl key (Windows) or Cmd key (Mac) while clicking on the objects.

Selected objects are highlighted in the scene.

2. Select how to replace the selected objects with lasers, lighting devices, or projectors by selecting the appropriate context
command.

¢ Replace Selected with > Lasers replaces selected objects of all one type with lasers.
¢ Replace Selected with > Lighting Devices replaces selected objects of all one type with lighting devices.
¢ Replace Selected with > Projectors replaces selected objects of all one type with projectors.

¢ Replace Selected > All with replaces selected objects with Lasers, Lighting Devices, or Projectors. Select the
appropriate sub-command.

e Replace Selected > Lasers with replaces all selected lasers with Lasers, Lighting Devices, or Projectors. Select the
appropriate sub-command.

¢ Replace Selected > Lighting Devices with replaces all selected lighting devices with Lasers, Lighting Devices, or
Projectors. Select the appropriate sub-command.

¢ Replace Selected > Projectors with replaces all selected projectors with Lasers, Lighting Devices, or Projectors
. Select the appropriate sub-command.

3. If replacing with lighting devices, the Replace with Lighting Devices dialog box opens. Select the replacement lighting
device.

¥ Click to show/hide the parameters.

Parameter Description




Fixture Mode

Lists the available lighting devices. The devices can be listed in different ways; click the
disclosure arrow to expand the category.

e All: Lists all lighting devices alphabetically by name.
e Manufacturer: Lists all lighting devices alphabetically by manufacturer name.
e Type: Lists all lighting devices alphabetically by type.

Click on the column heading to sort the list in ascending or descending order.

DMX Footprint

Displays the number of control channels used by the lighting device. Click on the column
heading to sort the list in ascending or descending order.

Search

Enter a search term, and click Search. Only lighting devices that contain the search term

display in the list; click a disclosure arrow to expand the list.

4. If replacing with lasers, the Replace with Lasers dialog box opens. Select the replacement laser.

¥ Click to show/hide the parameters.

Parameter

Description

Fixture Mode

Lists the available lasers. The lasers can be listed in different ways; click the disclosure arrow
to expand the category.

e All: Lists all lasers alphabetically by name.
e Manufacturer: Lists all lasers alphabetically by manufacturer name.

Click on the column heading to sort the list in ascending or descending order.

Search

Enter a search term, and click Search. Only lasers that contain the search term display in the
list; click a disclosure arrow to expand the list.

5. If replacing with projectors, the Replace with Projectors dialog box opens. Select the replacement projector.

» Click to show/hide the parameters.

Parameter

Description

Fixture Mode

Lists the available projectors. The projectors can be listed in different ways; click the

disclosure arrow to expand the category.

e All: Lists all projectors alphabetically by name.
e Manufacturer: Lists all projectors alphabetically by manufacturer name.
e Type: Lists all projectors alphabetically by type.

Click on the column heading to sort the list in ascending or descending order.

DMX Footprint

Displays the number of control channels used by the projectors. Click on the column heading

to sort the list in ascending or descending order.




Search Enter a search term, and click Search. Only projectors that contain the search term display in
the list; click a disclosure arrow to expand the list.

The original scene objects and/or fixtures are replaced in the Scene Graph palette and the scene. The replacement lighting
devices have the same name, universe, channel, position, and rotation as any original lighting devices. If the original and

replacement are both conventional lighting devices, the manual pan and tilt are maintained. The replacement lasers have the same
Name and Fixture Number as any original lasers.

The Scene Graph palette

Modifying scene objects and fixtures

Focusing conventional lighting devices

Deleting scene objects and fixtures

Command Path

e Delete Selected Context menu

e Delete Selected > All
e Delete Selected > Lasers
e Delete Selected > Lighting Devices

e Delete Selected > Projectors

You can easily delete objects and fixtures from the scene.
e If the selection contains only one type of item, delete them with the Delete Selected context command.

¢ If a mix of object types is selected, the appropriate context command will delete certain types of objects, or delete them
all.

To delete objects and/or fixtures from the scene:
1. Select the objects to delete.
Do one of the following:
¢ From the Scene Graph palette, select the object, laser, and/or lighting device to delete. Multiple objects can be
selected by selecting a layer, or by pressing the Shift key or the Ctrl (Windows) or Cmd (Mac) key while clicking on

the items.

¢ From the Scene window, select the object, laser, and/or lighting device to delete. Multiple objects can be selected by
pressing the Ctrl (Windows) or Cmd (Mac) key while clicking on the items.

Selected objects are highlighted in the scene.

2. Select the appropriate command.



¢ Delete Selected deletes selected items of all one type.

¢ Delete Selected > All deletes all of the selected items.

¢ Delete Selected > Lasers deletes all of the lasers in the selection.

¢ Delete Selected > Lighting Devices deletes all of the lighting devices in the selection.

¢ Delete Selected > Projectors deletes all of the projectors in the selection.

The Scene Graph palette

Modifying scene objects and fixtures

Replacing scene objects and fixtures

Updating GDTF fixtures

Command

Update Fixture Type | Context menu

You can modify GDTF fixtures in the scene by opening the GDTF Fixture Builder ( fixturebuilder.gdtf-share.com ) directly from

Vision. Internet access is required. When saving a fixture in the Fixture Builder, the associated .gdtf file is updated, along with each
instance of that fixture type in the scene. This is a local update to the scene file; it does not affect the fixture on the GDTF Share

( gdtf-share.com ). The .gdtf file is saved with the .v3s file.

To update a GDTF fixture:

1. Select the fixture in the Scene window, and select the command. The associated .gdtf file opens in the Fixture Builder

while Vision stays open in the background.

If the GDTF fixture is not properly configured, a list of errors displays. See the GDTF help ( gdtf-share.com/help/en/help/

gdtf builder/index.html ) for more information about creating a valid fixture.

2. Edit the fixture in the Fixture Builder. Only the DMX Mode name cannot be changed.
3. When the edits are complete, click Save to update the fixture.

4. Analert opens, confirming that you want to update all fixtures of this type in the scene. Click OK to update the .gdtf file

and all associated fixtures, and to close the Fixture Builder.

Data exchange for previsualization

Import options
The Scene Graph palette

Modifying scene objects and fixtures

Focusing conventional lighting devices
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Focusing conventional lighting devices

Command

Focus Selected Lights Here | Context menu

A conventional lighting device is a non-moving lighting device. If the conventional lighting devices are focused in Vectorworks prior
to import, they are automatically focused in Vision. Otherwise, these lights need to be manually adjusted so they point to the

desired location.

NOTE: By default, all unfocused conventional lighting devices point down in the hung position and point up in the floor-

mounted position.

To focus one or more conventional lighting devices:
1. Select the lighting device(s) to focus. The selected lighting devices automatically output light in the Scene window.
2. Right-click on the desired location in the scene, and select the command.
Alternatively, use the arrow keys to pan and tilt the selected lighting devices to achieve the desired focus.

The selected lighting devices are focused to the location.

When several conventional lighting devices are selected, each lighting device in the selection can be focused independently. Cycle

through the selected lighting devices to focus them one at a time.

To focus selected conventional lighting devices one at a time:
1. Select the lighting devices to focus. The selected lighting devices automatically output light in the Scene window.

2. Use the Page Up/Page Down keys to cycle through the selected lighting devices, based on their order in the Scene Graph
palette.

NOTE: Press the Page Down key to focus the first selected lighting device and to cycle down the list. Press the Page
Up key to focus the last selected lighting device and to cycle up the list.

The lighting device to focus displays its normal light beams, while the other lighting devices emit blue light.
3. Use the arrow keys to pan and tilt the highlighted lighting device to achieve the desired focus.

4. Continue pressing the Page Up or the Page Down key to cycle through the selected lighting devices. Use the arrow keys to

focus each lighting device as needed.

When the cycle is complete, all selected lighting devices display their normal light beams.



Cycle through the selected conventional lighting devices to focus them one at a time;
the device to focus is highlighted

The Scene Graph palette

Preferences

The Software Console palette

The Software Console palette

Command Shortcut

Software Console | Window | e  Ctrl+Shift+S (Windows)

e Cmd+Shift+S (Mac)

Additional properties of conventional (non-moving) lighting devices, such as gobo, iris, focus, and shutters, can be adjusted from the
Software Console palette. If the conventional lighting devices are imported from Vectorworks, some parameters, such as shutters

and barn doors, are already set.

To open the Software Console palette:

Select the command.

To adjust the properties of a conventional lighting device from the Software Console palette:
1. Select a conventional lighting device from the Scene Graph palette.
When selected, the lighting device automatically outputs light in the Scene window.

2. Inthe Software Console palette, adjust the sliders, or enter a value, to change the parameter settings. The available

parameters depend on the type of conventional lighting device selected.



The Scene window displays the result of the adjustment in real time.

Adjusting the value
changes the display in
the Scene window in
real time

The Scene Graph palette

The Properties palette

Preferences

Saving the scene as an image

Command

Render Still Render

Vision allows you to create still images of the Scene window displaying the current lighting status. When the Scene window displays
four viewports, the bottom right viewport is used to create the image. Still images are saved in .jpg format. Specify the image render

settings, and optionally save them as a set.

To save the Scene window as a still image:
1. Properly configure the scene and create the desired lighting look.
2. Select the command.
The Render Still dialog box opens.

» Click to show/hide the parameters.

Parameter Description




Settings Select a set of image render settings, or select <Active Settings>

Customize Opens the Vision Preferences dialog box to specify and save the image render settings
Resolution Select the image resolution in pixels, or select Custom Print Size

Print Size For printing purposes, displays the custom width and height in inches and the dpi
Output Filename Displays the image file name and location

3. Select a set of image render settings from the Settings list, or select <Active Settings> to use the settings currently

specified in the Vision Preferences dialog box.
4. Click Customize to specify the image render settings.

The Vision Preferences dialog box opens; only the Graphics tab is available. The top portion of the dialog box offers
options for saving and managing the render settings. The Graphics tab displays the rendering parameters. Set the

parameters as desired.

¥ Click to show/hide the parameters.

Parameter Description

Graphics Many of the same parameters display when setting the Vision application
preferences; see Basic: Graphics tab or Advanced: Graphics tab for parameter

descriptions

Render Buffer Size To help achieve the desired resolution, select a size that is smaller than the
Resolution in the Render Still dialog box.

NOTE: Smaller sizes increase the render time but also make it possible to
render high-resolution images.

5. Do one of the following:

e To save the current settings as a set, click Save. See Using saved sets for more information.

e To use the currently specified settings without saving them as a set, click OK.

6. From the Render Still dialog box, select the image Resolution. If the image will be printed, set the dpi.

For finer control of the print size, set the Resolution to Custom Print Size and specify the Print Size dimensions.

7. Click the button next to the Output Filename field, and set a name and location for the image file.

8. Click Render to save the image.

NOTE: If invalid data is entered, the Render button is disabled.



The Scene Graph palette

Saving the scene as a movie

Saving the scene as a movie

Command

Render Movie Render

Vision allows you to render the current scene and save it as a video file in .mpg format. To create a video, the scene must have an

associated DMKX file. Specify the movie render settings, and optionally save them as a set.

NOTE: If video screens or geometry are displaying video from a file or capture source within the scene, the video playback is not

synchronized to the exported video.

To save the Scene window as a video file:
1. Open the scene file to use for the video.
2. Select the command.
The Render Movie dialog box opens.

¥ Click to show/hide the parameters.

Parameter Description

Settings Select a set of movie render settings, or select <Active Settings>

Customize Opens the Vision Preferences dialog box to specify the movie render settings
Resolution Select the video resolution in pixels

Frame Rate Specify the frame rate in frames per second (fps)

DMX Recording Displays the DMX recording to use for the video

DMX Start Time Specify when to start the video in the DMX recording

DMX End Time Specify when to end the video in the DMX recording

Output Filename Displays the video file name and location

3. Select a set of movie render settings from the Settings list, or select <Active Settings> to use the settings currently
specified in the Vision Preferences dialog box.

4. Click Customize to specify the movie render settings.



The Vision Preferences dialog box opens, but only the Graphics tab is available. The top portion of the dialog box offers
options for saving and managing the render settings. The Graphics tab displays the rendering parameters. Set the
parameters as desired.

¥ Click to show/hide the parameters.

Parameter Description

Graphics Many of the same parameters display when setting the Vision application
preferences; see Basic: Graphics tab or Advanced: Graphics tab for parameter

descriptions

Render Buffer Size To help achieve the desired resolution, select a size that is smaller than the
Resolution in the Render Movie dialog box. Smaller sizes increase the render

time but also make it possible to render high-resolution videos.

NOTE: To create bloom effects in the movie, the Render Buffer Size must be

greater than or equal to the Resolution.

5. Do one of the following:

e To save the current settings as a set, click Save. See Using saved sets for more information.

e To use the current settings without saving them as a set, click OK.

6. From the Render Movie dialog box, select the video Resolution.

7. Select the video Frame Rate.

8. Click the button next to the DMX Recording field, and select the DMX file to use for the video.

9. Set the DMX Start Time and the DMX End Time.

10. Click the button next to the Output Filename field, and set a name and location for the video file.

11. Click Render to save the video.

NOTE: If invalid data is entered, the Render button is disabled.

The progress bar displays while the video renders. The actual rendering does not display on the screen.

To cancel the rendering and save the video file as-is, click Cancel. The file is saved in the specified location.

The Scene Graph palette

Saving the scene as an image




Patching

Command Path Shortcut

Patch Window | e  Ctrl+Shift+P (Windows)
e Cmd+Shift+P (Mac)

Use the Patch dialog box to view and edit the DMX address of the following scene items:

e Lighting devices

e Projectors

e RGB mesh objects

e Layers with DMX transforms

e DMX-controlled cameras

e DMX-controlled ambient intensities

e DMX-controlled haze vertical/horizontal speeds

The Patch list can be sorted and filtered to show the desired data. Edit the address of a single item directly from the Patch list. Use
context menu commands to edit the patching of multiple items: set the universe, patch items sequentially, and resolve conflicts (see

Assigning patch information). In addition to DMX patching, you can export, import, and print patching data.

Channel Availability
Filter diagram
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To open the Patch dialog box:



Select the command.

¥ Click to show/hide the parameters.

Parameter Description

Filter Filters the scene items by a specified universe, lighting device manufacturer, item type, or
displayed name. Select Show All to display all of the patchable scene items in the Patch
list.

The Filter field is also a search box. Type some or all of the text for the desired filter and
press Enter; the search is not case sensitive.

Export Exports the patch information for all scene items in comma-separated value (csv) format

to a Vision .v3p patch file; specify the file name and location

Import Imports patch information from a Vision .v3p patch file

Print Saves the patch information as a PDF file

Close Closes the Patch dialog box

Patch list Lists the scene items and their patch information (according to the selected Filter),

including universe and channel assignment; click on a column heading to sort the list in

ascending or descending order

Channel Availability Displays channel usage per universe. Green areas represent channels in use; red are in
conflict.

The number of universes shown depends on the Vision dongle and license.

Assigning patch information

Viewing received DMX

Using DMX controls

Assigning patch information

Properly configured addresses are required for scene items to respond to a DMX lighting console. In Vision, all universes and
channels start at 1, not O (zero).

Lighting devices, RGB mesh objects, and DMX transforms can be patched from the Properties palette or the Patch dialog box. DMX-
controlled items can be patched from the DMX Controls dialog box or the Patch dialog box.

The Patch dialog box displays all patchable scene items and their address information, sorted and filtered as desired. The channel
availability diagram shows channel usage and errors for each universe.

NOTE: The number of universes depends on the Vision dongle and license.



Setting the address

To quickly change the address of a single item:

1. From the Patch list, double-click on the Universe or Channel number.

2. Edit the value directly.

To set the universe for a selection of items:

Command

Set Universe Context menu

1. Select one or more items from the Patch list.
2. Right-click on a selected item and select the command.
The Set Universe dialog box opens.

3. Specify a universe for the item or items.

Patching sequentially

Command

Patch Sequentially | Context menu

A selection of items can be assigned to sequential channels in a specified universe.

To patch items sequentially:
1. Select the items from the Patch list.
2. Right-click on a selected item and select the command.

The Patch Sequentially dialog box opens.

3. Specify a universe for the items, and then set the first channel.

The selected items are patched sequentially based on the specified start address.

Resolving conflicts

Command

Resolve Conflicts | Context menu




When there is a conflict due to overlapping or duplicated addresses, they display with a red highlight in the Patch list and the

Channel Availability diagram. Conflicts can be resolved automatically.

To resolve conflicts:
1. Select the items with a conflict from the Patch list.
2. Right-click on a selected item and select the command.

If space is available in the universe, an appropriate DMX address is assigned to the items, resolving the conflicts.

Patching
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Using DMX controls

Viewing received DMX

Command

DMX Viewer DMX

When a lighting console is connected, you can view the DMX information sent from the console.

NOTE: The DMX Viewer does not work with MA-Net3.

To view the DMX information:
1. Select the command.
The DMX Provider dialog box opens.
2. Specify the protocol to connect to the lighting console, and click OK.

The DMX Viewer opens. This is a separate dialog box that opens along with Vision, and it can remain open while Vision is

running.

3. For each selected Universe, the current DMX information sent from the console displays. The Display Type can be

toggled between Decimal and Percentage.

4. Click X to close the DMX Viewer.

Patching
Assigning patch information

Using DMX controls




Using DMX controls

Vision uses DMX to allow a lighting console, or a program such as Disguise EVO, to control specific features of the application. These
features include:

e Cameras that control the viewport view
e Ambient lighting intensity

e Haze speed in vertical and horizontal directions

e Projectors

When these features are properly patched, the lighting console or the Disguise program can sync with Vision and control the
features with DMX.

Three camera types can be controlled externally. The cameras have different behavior, as described in the following sections:

e Relative camera: DMX control of the Relative camera

e Absolute camera: DMX control of the Absolute camera

e Disguise camera: DMX control of the Disguise camera

The DMX information follows the Last Takes Precedence (LTP) priority; the latest information sent takes priority. The patching is
saved in the .v3s file.

Patching
Viewing received DMX

DMX control of ambient lighting

DMX control of haze speed

DMX control of projectors

DMX control of the Relative camera

Command Path Shortcut

DMX Controls | DMX | e  Ctrl+Shift+C (Windows)
e Cmd+Shift+C (Mac)

The Relative camera is an orbiting camera that allows unlimited movement within the Vision scene. It uses DMX to control the
direction and speed of camera movement. The camera relies on saved views to provide a starting view point. Up to nine saved
camera views are available, corresponding to the nine Relative camera items in the DMX Controls dialog box. These virtual views are
set up and stored in the .v3s file.

To enable external control of the Vision view with a Relative camera:

1. Select the command.

The DMX Controls dialog box opens.



2. To activate and control the camera views, select the check box for the Camera (Relative) to use and specify the
Universe and Channel number. There are 11 channels per DMX camera.

Channel Coarse/Fine Purpose %: Function
1 Activation e 0-49: Deactivate camera
e 50-100: Activate camera
2 Coarse Pan Horiz e 0-0:Nopan
e 1-48: Pan left
) e 49-51: No pan
3 Fine e 52-99: Pan right
e 100-100: No pan
4 Coarse Pan Vert e 0-0:Nopan
e 1-48:Pan down
) e 49-51: No pan
> Fine e 52-99: Pan up
e 100-100: No pan
6 Coarse Orbit Horiz e 0-0: No orbit
e 1-48: Orbit left
) e 49-51: No orbit
/ Fine e 52-99: Orbit right
e 100-100: No orbit
8 Coarse Orbit Vert e 0-0: No orbit
e 1-48: Orbit up
] e 49-51: No orbit
9 Fine «  52-99: Orbit down
e 100-100: No orbit
10 Coarse Zoom e 0-0: Nozoom
e 1-48:Zoomin
) e 49-51: Nozoom
1 Fine e 52-99: Zoom out
e 100-100: No zoom

e 1% = decreasing quickly
e 50% = no change
e 99% = increasing quickly

When Vision is synced with a lighting console, or other integrated program, activating a Relative camera changes the
viewport to the selected camera view.

Using DMX controls
Patching
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Viewing received DMX

DMX control of the Absolute camera

Command Path Shortcut

DMX Controls | DMX | e  Ctrl+Shift+C (Windows)
e Cmd+Shift+C (Mac)

The Absolute camera uses DMX to set the camera position. This camera navigates the Vision scene within a fixed range of
movement: -1000 m to 1000 m on any given axis. Unlike the Relative camera, the Absolute camera moves by pan and tilt (or yaw

and pitch motion) instead of orbiting. You can control the field of view, and saved views are not required.

NOTE: Because the Disguise Camera uses the same functionality as the Absolute Camera, they cannot be active at the same
time.

To enable external control of the Vision view with an Absolute camera:
1. Select the command.
The DMX Controls dialog box opens.

2. To activate the camera view, select the check box for Camera (Absolute) and specify the Universe and Channel number.

Channel Coarse/Fine/Ultra Purpose %: Function

1 Coarse Position X 0-100: -1000m—1000m
2 Fine

3 Ultra

4 Coarse Position Z 0-100: -1000m-1000m
5 Fine

6 Ultra

7 Coarse Position Y 0-100: -1000m-1000m
8 Fine

9 Ultra

10 Coarse Pan 0-100: -720°-720°

11 Fine




12 Ultra
13 Coarse Tilt 0-100: -720°-720°
14 Fine
15 Ultra
16 Coarse Vertical Field of View (FOV) 0-100: 22.5°-225°
17 Fine
18 Ultra

When Vision is synced with a lighting console, or other integrated program, the view changes to match the Absolute

camera position.

Using DMX controls
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DMX control of the Disguise camera

Command Path Shortcut

DMX Controls | DMX | e  Ctrl+Shift+C (Windows)
e Cmd+Shift+C (Mac)

Vision uses a DMX-controlled camera to sync with Disguise EVO for media programming. See Rendering video with Disguise EVO for

more information on enabling and disabling the Disguise integration. The Disguise camera is a type of Absolute camera; its behavior

is described in DMX control of the Absolute camera.

NOTE: The Disguise Camera and the Absolute Camera cannot be active at the same time.

To enable Disguise to control the Vision view:
1. Select the command.
The DMX Controls dialog box opens.

2. To activate the Disguise camera, select the check box for Disguise Camera and specify the Universe and Channel number.

Channel Coarse/Fine/Ultra Purpose %: Function

1 Coarse Position X 0-100: -1000m—1000m




2 Fine

3 Ultra

4 Coarse Position Z 0-100: -1000m-1000m
5 Fine

6 Ultra

7 Coarse Position Y 0-100: -1000m-1000m
8 Fine

9 Ultra

10 Coarse Pan 0-100: -720°-720°

11 Fine

12 Ultra

13 Coarse Tilt 0-100: -720°-720°

14 Fine

15 Ultra

16 Coarse Vertical Field of View (FOV) 0-100: 22.5°-225°

17 Fine

18 Ultra

3. Ifthe rendering preferences have not already been set for Disguise integration, two alerts open. When prompted, click
Yes to send a live NDI® stream of Vision and to render video screens with Disguise.

Using DMX controls
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DMX control of ambient lighting

Command Path Shortcut



DMX Controls | DMX | e  Ctrl+Shift+C (Windows)
e Cmd+Shift+C (Mac)

To use DMX for the ambient intensity:
1. Select the command.

The DMX Controls dialog box opens.

2. To control the ambient intensity, select the check box for Ambient Intensity and specify the Universe and Channel

number.
Channel Coarse/Fine Purpose %: Function
1 Ambient e 0-0: No ambient
e 1-100: Ambient value

Using DMX controls
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DMX control of haze speed

Command Path Shortcut

DMX Controls | DMX | e  Ctrl+Shift+C (Windows)
e Cmd+Shift+C (Mac)

To use DMX for the haze speed:
1. Select the command.

The DMX Controls dialog box opens.

2. To control the speed of the haze texture image as it moves in vertical and horizontal directions, select the check box for

Haze Vertical/Horizontal Speed and specify the Universe and Channel number.

Channel Coarse/Fine Purpose %: Function

1 Coarse Haze Vertical Speed e 0-0: No direction

e 1-48:Haze left

e 49-51: No direction

e 52-99: Haze right

e 100-100: No direction

2 Fine




Channel Coarse/Fine Purpose %: Function

1 Coarse Haze Horizontal Speed e 0-0: No direction

e 1-48: Haze left

e 49-51: No direction

e 52-99: Haze right

e 100-100: No direction

Using DMX controls
Patching
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DMX control of projectors

Command Path Shortcut

DMX Controls | DMX | e  Ctrl+Shift+C (Windows)
e Cmd+Shift+C (Mac)

DMX control of the projectors depends on the number of channels available. The projector name indicates how many channels it

has.

To use DMX for the projectors:
1. Select the command.
The DMX Controls dialog box opens.

2. To control the projector, select the check box for Projector and specify the Universe and Channel number.

Number of Channel Purpose %: Function
Channels
1 1 Dimmer
2 1 Dimmer
2 Zoom
4 1 Pan 0-100: -720°-720°
2
3 Tilt 0-100: -720°-720°
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The DMX recorder

Command Shortcut

DMX Recorder | Window | e  Ctrl+Shift+D (Windows)
e Cmd+Shift+D (Mac)

Vision allows real-time recording of the incoming DMX stream. This recorded DMX stream can be used to play back lighting looks

and sequences when no controller is connected.

To open the DMX Recorder:
Select the command.

The DMX Recorder is a separate application that opens along with Vision.

Play/Pause Loop

Return to Q000000 Recard/Stop

\s DIVIX Recorder

Timeline slider

00:00:00

H,L j . Current position
L of in the timeline
00:00:00

Load DMX Convert DMX

¥ Click to show/hide the parameters.

Parameter Description

Timeline slider Scrubs the timeline to the desired location; click Play to begin viewing the DMX file at that
location

Return to 00:00:00 Returns the timeline slider to the start point of the DMX file and stops the play

Play/Pause Toggles between playing and pausing the DMX file

Record/Stop Press once to start recording the DMX file, and press again to stop recording and save the file

Loop When the DMX file ends, loops the playback to the beginning to continuously play the file;
press again to stop looping

Load DMX Opens a DMX file for playback; the DMX file needs to correspond with the lighting devices in
the current Vision file for correct playback to occur




Convert DMX Opens a DMX file for conversion from a previous version of Vision

Recording a DMX file

Before recording, ensure that the lighting console is properly connected and that the correct communication protocol has been

specified.

E To record from a DMX stream:

1. Click Record on the DMX Recorder.

2. Send the DMX stream to Vision. All DMX values are recorded as they are received; any subsequent cues or effects played
on the lighting console will be recorded.

3. Click Record again to stop the recording.

The Save DMX dialog box opens. Specify a name and location for the .dmx file. The saved DMX file is currently loaded by
default and is ready to play, or it can be loaded and played by selecting it with Load DMX.

Opening a DMX file

To open (load) a DMX file:
1. Click Load DMX on the DMX Recorder.
The Load DMX dialog box opens.

2. Select the .dmx file to open.

Playing a DMX file

Before playing the currently loaded DMX file, open the corresponding Vision file.

E] To play the current DMX file:

1. Click Play on the DMX Recorder.
The DMX file plays in Vision, replacing the current view in the Scene window.

2. To pause the playback, click Play again. The Scene window returns to its former display. Click Play to resume the

playback.

At the end of the timeline, playback stops and the Scene window returns to its former display, unless Loop mode is

enabled. Looping playback continues until Loop is disabled or the playback is paused.



Pausing a DMX file

E] To pause the DMX file:

1. Click Play on the DMX Recorder.
The Scene window pauses; the DMX signal input continues, but DMX playback from the file is paused.

2. Click Play again. DMX playback from the file resumes in the Scene window.
Looping DMX file playback

To loop DMX file playback:

1. Click Loop on the DMX Recorder.
2. Click Play.

The DMX file begins playback. At the end of the timeline, playback loops back to the beginning and plays continuously
until Loop is disabled.




Using the help system

For information about this help system, navigate to help.vectorworks.net and refer to the section on using the help.

Context-sensitive help

Context-sensitive help is available within the Vision program. To learn more about a feature, do one of the following:

e For a dialog box, click the ? icon on the Title bar.

V7 Lighting Device

Fixture Mode

» Type

» Manufacturer
» All

e For a selected tool or dialog box, press F1.
NOTE: On a Mac (aluminum keyboard), press Fn+F1.

e Foratool, a palette, the Scene window, or the NDI® status indicator, select Help > What’s This? Then move the question

mark cursor to the feature of interest, and click it.
NOTE: To deactivate the “What’s This?” question mark cursor, select Help > What’s This? again.
The relevant help topic is opened. You can simultaneously view the help and the Vision application.

Vision cannot directly access context-sensitive help for some commands. To view help for these items, launch the help system and

locate the topic by conducting a search.


http://help.vectorworks.net
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